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入门 1
使用 Molecule Profiler 软件搜索和报告使用 Analyst TF 软件和 SCIEX OS 采集的数据中的分
子及其衍生物，包括可能杂质和代谢物。

Molecule Profiler 软件支持识别 10 kDa 以下的小分子、肽、抗体药物共轭物和寡核苷酸。

选择化合物 处理批次 审核结果 细化结果

化合物谱库 创建批次 关于 Results 工作
区

表征 MS/MS 数据

创建生物转化组 设置 处理参数 关于结果筛选器 关联结果

设置 处理参数 指定批次选项 编辑结果 在 Correlation 工
作区中创建报告

或

导入批次 使用 Add MS/MS
按钮添加多个谱

图

在 Results 工作区
中创建报告

如何找到可能分子及其衍生物
软件有一系列找峰策略（或算法），利用它们在感兴趣样本中寻找可能的分子。请参阅以下章
节：关于找峰策略。

如果找到的峰是预测的分子，则软件为其指定源自母离子或者一个或多个生物转化的组合的特
定名称。根据工作流程，生物转化可能包括选定生物转化组、可能裂解代谢物或可能水解裂
解，或来自抗体的可能序列碎片。

对于小分子数据分析，生物转化包括选定生物转化组和可能裂解代谢物。

对于肽数据分析，生物转化包括选定生物转化组和可能水解裂解。

入门
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对于抗体药物共轭物 (ADC) 数据分析，生物转化包括选定生物转化组、可能裂解代谢物和来
自消化抗体蛋白质的可能序列碎片。

对于寡核苷酸分析，生物转化包括同时适合代谢物和杂质的生物转化组选择，以及可能裂解代
谢物和内部 n–1 和基端 n+1 序列。

如果使用一般找峰策略，并且如果峰是意外的分子，则指定名称的一般损失或增益以及分子离
子电荷处的质子化加合物。

如果为样本选择了对照文件，则软件对样本和对照品数据执行比较。如果还为样本选择了模拟
文件，则软件对 MS 和模拟数据执行比较。

用户可以更改控制每种算法的参数。请参阅以下章节：选择参数值。

打开 Molecule Profiler 工作区
必须安装 SCIEX OS 软件 2.1.5 或更高版本，并且必须激活有效的 Molecule Profiler 软件许可
证。

1. 从 Start 菜单中选择软件：Start > SCIEX OS > SCIEX OS。

如果软件进行了 Integrated 模式配置，则会打开 Home 页面。

如果软件进行了 Mixed 模式配置，则会打开 Logon 对话框。继续进行以下步骤。

2. 如果 Logon 对话框打开，则键入有权使用该软件的用户的用户名和密码，然后单击 OK。
此时主页便会打开。

3. 单击 Molecule Profiler 图标。

图 1-1 Molecule Profiler 图标

Molecular Profiler 工作区随即打开。

入门
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Molecule Profiler 窗口

图 1-2 Molecule Profiler 窗口

项目 描述

1 工作区列表

2 Batch 工作区。使用此工作区搜索可能代谢物。请参阅以下章节：关于
Batch 工作区。

3 Results 工作区。处理之后使用此工作区查看可能代谢物。请参阅以下章
节：关于 Results 工作区。

4 Correlation 工作区。使用此工作区比较在不同结果文件中发现的代谢物。
请参阅以下章节：关于 Correlation 工作区。

5 工作流程列表

6 化合物谱库。创建和维护化合物的谱库。请参阅以下章节：化合物谱库。

7 生物转化。创建和维护常见生物转化的列表。请参阅以下章节：生物转化
组。

入门
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项目 描述

8 处理参数。创建和维护可在批次工作区中使用的处理方法。请参阅以下章
节：创建处理方法。

9 菜单栏。请参阅表格：表 1-1。

表 1-1 菜单命令

项目 描述

File 菜单

New • Batch：创建新批次。请参阅以下章节：创建批次。

• Correlation：创建新相关性。请参阅以下章节：准备相关性。

Open • Batch：打开批次。

• Correlation：打开相关性文件。

• Results：打开结果文件。

Save Batch 在 Batch 工作区中保存批次。

Save Batch As 在 Batch 工作区中使用不同的名称保存批次。

Create Report 创建报告。请参阅以下章节：报告。

Recent reports 打开近期的报告。

Edit 菜单

Edit Name 编辑化合物的名称和化学式。

Copy Selected
Table

复制所选的表。

Copy Selected
Graph

复制所选图形。

Copy Batch
Row

复制所选批次行。

Paste Batch
Row

将复制的批次行粘贴到所选位置。

Clear Batch
Row

删除所选批次行的内容。

Delete Selected
Row

从结果表中删除所选的行。软件会重新计算结果。

Undo Delete 恢复上次删除的行。软件会重新计算结果。

Hide
Unchecked
Rows

隐藏未选择的行。

入门
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表 1-1 菜单命令 (续)

项目 描述

Show Hidden
Rows

显示未选择的行。

Custom
Elements

打开 Custom Elements 对话框。使用此对话框定义氨基酸和寡核苷酸残
基。请参阅以下章节：Custom Elements。

Setup 菜单

Compound
Library

打开化合物谱库。请参阅以下章节：化合物谱库。

Biotransformati
ons

打开生物转化组列表。请参阅以下章节：生物转化组。

Processing
Parameters

打开处理方法窗口。请参阅以下章节：创建处理方法。

Filters • Results：为 Results 工作区设置筛选器。请参阅以下章节：关于结果
筛选器。

• Correlation：为 Correlation 工作区设置筛选器。请参阅以下章节：关
于相关性筛选器。

• Interpretation：为 Interpretation 工作区设置筛选器。

Create New
Folder

创建文件夹。请参阅以下章节：创建文件夹。

创建文件夹
文件夹存储软件在感兴趣样本中寻找可能分子所需的文件以及结果文件。

还可创建自定义文件夹以整理结果。

1. 单击 Setup > Create New Folder。
Create New Folder 对话框随即打开。

2. 键入文件夹的 Name。
Location 字段显示数据目录的安装位置
(C:\ProgramData\SCIEX\Molecule Profiler\Data)。创建的所有文件夹都存储

在此目录中。

3. 单击 OK。

创建文件夹时，将自动创建两个子文件夹，即 Processing Parameters 文件夹和

Results 文件夹。

入门
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Custom Elements 2
Custom Elements 对话框包含下列选项卡：

• AA List 选项卡包含标准氨基酸列表的信息。这些信息无法编辑或删除。用户可以向此列表
添加自定义氨基酸，然后根据需要修改或删除添加的项。添加的氨基酸自动添加到列表底
部。但是，可单击任一列标题对列表进行排序。

• AA Modifications 选项卡包含可应用于肽端基和氨基酸残基侧基的各种修饰的质量偏移信
息。这些信息无法编辑或删除。用户可以向列表中添加自定义氨基酸修饰，然后根据需要
修改或删除添加的项。添加的氨基酸修饰自动添加到列表底部。但是，可单击任一列标题
对列表进行排序。

• Oligo List 选项卡包含预定义寡核苷酸残基和端基。这些信息无法编辑或删除。用户可以向
此列表添加新的寡核苷酸残基和端基，然后根据需要修改或删除添加的项。添加的残基自
动添加到列表底部。但是，可单击任一列标题对列表进行排序。

自定义氨基酸

创建自定义氨基酸

1. 单击 Edit > Custom Elements。
Custom Elements 对话框随即打开。

2. 确认已选中 AA List 选项卡。

3. 单击 New。
New Custom Amino Acid Residue 对话框随即打开。

4. 完成下表中所述的字段，然后单击 OK。

表 2-1 New Custom Amino Acid Residue 对话框字段

字段 描述 可接受值

Name 氨基酸的名称 字母数字

Symbol 氨基酸的符号 • 字母数字

• 第一个字母应为大写

Residue
Formula

氨基酸的化学式 经验式，使用周期元素。富集同位
素也可用作化学式的组成部分。例
如 13C，其中 13C 表示碳 13 同位
素。

自定义氨基酸添加到氨基酸表底部，并显示名称、符号和质量。

编辑自定义氨基酸

1. 单击 Edit > Custom Elements。

Custom Elements
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Custom Elements 对话框随即打开。

2. 确认已选中 AA List 选项卡。

3. 选择要编辑的氨基酸。

注释: 只能编辑用户添加的自定义氨基酸。随软件一起分发的氨基酸不能编辑。

4. 单击 Edit。
Edit Custom Amino Acid Residue 对话框随即打开。

5. 编辑下表中所述的字段。

表 2-2 Edit Custom Amino Acid Residue 对话框字段

字段 描述 可接受值

Name 氨基酸的名称 字母数字

Symbol 氨基酸的符号 • 字母数字

• 第一个字母应为大写

Residue
Formula

氨基酸的化学式 经验式，使用周期元素

6. 单击 OK。
如果适用，所选自定义氨基酸的名称、符号和质量在氨基酸表中相应地更新。

删除自定义氨基酸

注释: 删除处理方法或结果中使用的自定义氨基酸可能会导致意外行为。

1. 单击 Edit > Custom Elements。
Custom Elements 对话框随即打开。

2. 确认已选中 AA List 选项卡。

3. 选择要删除的氨基酸。

注释: 只能删除用户添加的自定义氨基酸。随软件一起分发的氨基酸不能删除。

4. 单击 Delete。
自定义氨基酸将从氨基酸表中删除。

自定义氨基酸修饰

创建自定义氨基酸修饰

注释: 自定义氨基酸修饰只能应用于标准氨基酸。

1. 单击 Edit > Custom Elements。
Custom Elements 对话框随即打开。

Custom Elements
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2. 确认已选中 AA Modifications 选项卡。

3. 单击 New。
New Custom Modification 对话框随即打开。

4. 完成下表中所述的字段，然后单击 OK。

表 2-3 New Custom Modification 对话框字段

字段 描述 可接受值

Name 残基的名称 字母数字

Symbol 残基的符号 • 必须以 _ 开头

• 字母数字

• 第一个字母应为大写

Formula Gain 增益该残基的化学式 经验式，使用周期元素

Formula Lost 损失该残基的化学式 经验式，使用周期元素

Mod Type 修饰的位置 氨基酸、氨基端、羧基端、蛋白氨
基端和蛋白羧基端

Applies to AA 相关氨基酸的名称 将应用自定义修饰的标准氨基酸的
单个字母表示形式，例如，P 代表
脯氨酸。留空此字段以对所有标准
氨基酸应用自定义修饰。

自定义氨基酸修饰添加到氨基酸修饰表底部，并显示符号、质量偏移和名称。

编辑自定义氨基酸修饰

1. 单击 Edit > Custom Elements。
Custom Elements 对话框随即打开。

2. 确认已选中 AA Modifications 选项卡。

3. 选择要编辑的修饰。

注释: 只能编辑用户添加的修饰。随软件一起分发的修饰不能编辑。

4. 单击 Edit。
Edit Custom Modification 对话框随即打开。

5. 编辑下表中所述的相应字段。

表 2-4 Edit Custom Modification 对话框字段

字段 描述 可接受值

Name 残基的名称 字母数字

Custom Elements

Molecule Profiler 软件
14/127

软件用户指南
RUO-IDV-05-12707-ZH-A



表 2-4 Edit Custom Modification 对话框字段 (续)

字段 描述 可接受值

Symbol 残基的符号 • 必须以 _ 开头

• 字母数字

• 第一个字母应为大写

Formula Gain 增益该残基的化学式 经验式，使用周期元素

Formula Lost 损失该残基的化学式 经验式，使用周期元素

Mod Type 修饰的位置 氨基酸、氨基端、羧基端、蛋白氨
基端和蛋白羧基端

Applies to AA 相关氨基酸的名称 将应用自定义修饰的标准氨基酸的
单个字母表示形式，例如，P 代表
脯氨酸。留空此字段以对所有标准
氨基酸应用自定义修饰。

6. 单击 OK。
如果适用，所选自定义修饰的名称、符号和质量偏移在修饰表中相应地更新。

删除自定义氨基酸修饰

注释: 删除处理方法或结果中使用的自定义氨基酸修饰可能会导致意外行为。

1. 单击 Edit > Custom Elements。
Custom Elements 对话框随即打开。

2. 确认已选中 AA Modifications 选项卡。

3. 选择要删除的修饰。

注释: 只能删除用户添加的自定义修饰。随软件一起分发的修饰不能删除。

4. 单击 Delete。
自定义修饰将从修饰表中删除。

自定义寡核苷酸残基或端基
使用自定义元素创建包含可添加到寡核苷酸核结构的自定义官能团的序列。这些修饰可在序列
中输入，然后由 Molecule Profiler 软件搜索和识别。

寡核苷酸可以分解成多个子结构。

Custom Elements
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图 2-1 寡核苷酸子结构

用户可以更改寡核苷酸的核子结构，也可以定义新核、基端和磷酸骨架。创建自定义修饰序列
时，使用这种统一结构：

5'-(Terminus Moiety)-(Terminus Linker)-(Terminus Phosphate Core)-(Residue Type)1-…-
(Residue Type)n-(Terminus Phosphate Core)-(Terminus Linker)-(Terminus Moiety)-3'

在 New Oligo Residue or Terminus 对话框中，Type 字段包含多种预定义的残基或基端类型。
这些预定义类型可限制对寡核苷酸的某些子结构进行的编辑，以简化该类型自身特有的修饰的
创建。为了理解每种类型如何适应上面概括的一般结构，请参阅下表。

表 2-5 类型

类型 类别 可编辑子结构

DNA 残基类型 碱基

DNA* 残基类型 碱基

RNA 残基类型 碱基

RNA* 残基类型 碱基

2'-O-甲基 RNA 残基类型 碱基

2'-O-甲基 RNA* 残基类型 碱基

锁定 (LNA) 残基类型 碱基

锁定 (LNA)* 残基类型 碱基

Custom Elements
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表 2-5 类型 (续)

类型 类别 可编辑子结构

其他残基 残基类型 碱基

5' 交联剂

糖核

3' 交联剂

磷酸核

磷酸基端* 基端基团 基端基团

磷酸基端 基端基团 基端基团

其他基端 基端基团

基端交联剂

基端磷酸核

基端基团

基端交联剂

磷酸核

* 硫代磷酸化骨架

添加和编辑化学式时最灵活的类型是“其他残基”。它可以进行更改以适应多种不同的自定义子
结构，使用户能够定义高度自定义的寡核苷酸。类似地，“其他基端”类型允许用户定义其自定
义 5' 或 3'-基端、交联剂和核。

有关示例，请参阅以下章节：自定义寡核苷酸示例。

创建自定义寡核苷酸残基或端基

提示! 要通过复制现有的寡核苷酸残基或端基来创建寡核苷酸残基或端基，在 Oligo List 选项
卡中选择现有的项，然后单击 New From。

1. 单击 Edit > Custom Elements。
Custom Elements 对话框随即打开。

2. 确认已选中 Oligo List 选项卡。

该列表包含所有预定义寡核苷酸残基和端基。

3. 单击 New。
New Oligo Residue or Terminus 对话框随即打开。

4. 填充对话框中的字段。有关示例，请参阅以下章节：自定义寡核苷酸示例。

5. 单击 OK。
自定义残基或端基添加到该表底部。

编辑自定义寡核苷酸残基或端基

1. 单击 Edit > Custom Elements。

Custom Elements
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Custom Elements 对话框随即打开。

2. 确认已选中 Oligo List 选项卡。

3. 选择要编辑的残基或端基。

注释: 只能编辑用户添加的残基和端基。随软件一起分发的残基和端基不能编辑。

4. 单击 Edit。
Edit Custom Amino Acid Residue 对话框随即打开。

5. 编辑残基或端基的属性。

6. 单击 OK。

删除自定义寡核苷酸残基或端基

注释: 删除处理方法或结果中使用的自定义寡核苷酸残基或端基可能会导致意外行为。

1. 单击 Edit > Custom Elements。
Custom Elements 对话框随即打开。

2. 确认已选中 Oligo List 选项卡。

3. 选择要删除的残基或端基。

注释: 只能删除用户添加的残基和端基。随软件一起分发的残基和端基不能删除。

4. 单击 Delete。
自定义残基或端基将从表中删除。

导入寡核苷酸残基和端基

寡核苷酸残基和端基可以从文本文件导入。

1. 单击 Edit > Custom Elements。
Custom Elements 对话框随即打开。

2. 确认已选中 Oligo List 选项卡。

该列表包含所有预定义寡核苷酸残基和端基。

3. 单击 Import。
Import Text File 对话框随即打开。

4. 浏览到文本文件，将其选中，然后单击 Open。

导出寡核苷酸残基和端基

寡核苷酸残基和端基可以导出到文本文件。

1. 单击 Edit > Custom Elements。
Custom Elements 对话框随即打开。

2. 确认已选中 Oligo List 选项卡。

该列表包含所有预定义寡核苷酸残基和端基。

Custom Elements
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3. 选择要导出的寡核苷酸残基和端基。

提示! 按下 Ctrl+A 选择列表中的所有残基和端基。

4. 单击 Export。
此时会打开 Save As 对话框。

5. 键入用于保存导出的寡核苷酸残基和端基的文本文件的名称。

Custom Elements
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化合物谱库 3
化合物谱库可存储化合物的信息，包括化学式、结构或序列、同位素模式以及 MS/MS 谱图。
用户还可以为每种化合物指定参考谱图。谱库中的每个条目都可用于创建处理参数。

软件安装时带有基础化合物谱库，但是用户可以通过添加、编辑和删除条目自定义该谱库。

注释: 每个条目都需要一个化学式和至少一个 MS/MS 谱图。

化合物谱库选项

添加结构 添加肽序列 添加寡核苷酸序列

如何使用结构和序列
软件使用化学结构以及肽和寡核苷酸序列生成化合物特定的参数值，例如可能裂解代谢物。

注释: 软件根据结构或序列自动生成化学公式。

软件接受 v2000 和 v3000 mol 文件，包括带有 Markush 或多种结构的文件。

添加结构
使用 wiff 文件和 txt 文件向化合物谱库中的单个条目添加参考谱图。

1. 在 Workflow 面板中，单击 Compound Library。
Compound Library 对话框随即打开。

2. 执行以下任一操作：

• 创建新化合物。

a. 单击 New，然后从选项列表中选择 Structure。

New Entry 对话框随即打开。

b. 键入化合物的 Name，然后单击 OK。

软件自动使用提供的名称填充 Compound Library 对话框中的 Compound name
字段。

• 从 Compound name 字段中提供的列表选择一种化合物。

Compound Library 对话框更新为与所选化合物对应的信息。

3. 单击 Open Structure。
Open Structure File 对话框随即打开。

4. 浏览到有效的 mol 文件，然后将其选中。

化合物谱库
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5. 单击 Open。

软件将填充 Compound Library 对话框中的下列字段：

• Structure

• Chemical formula

• Polarity

• Isotope Pattern

默认情况下，Adduct 字段填充为单电荷质子化加合物 [M+H]+ 或 [M-H]–。软件还会使用
相应的信息更新 m/z 字段。

6. 选择采集的 Polarity。
Compound Details 选项卡上的 Isotope Pattern 以及 m/z 和 Adduct 值根据所选的极性
更新。

7. 使用相应的信息填写下列字段：

• Compound class

• CAS number

• Comments（例如，关于代谢物类别的信息可添加到此字段。）

8. 打开 Experimental Data 选项卡。

9. 执行以下任一操作：

• 要从 wiff 文件添加参考 MS/MS 谱图，请继续以下章节：从 wiff 文件添加参考 MS/MS
谱图。

• 要从 txt 文件添加参考 MS/MS 谱图，请继续以下章节：从 txt 文件添加参考 MS/MS 谱
图。

添加肽序列
使用 wiff 文件和 txt 文件向化合物谱库中的单个条目添加参考谱图。

1. 在 Workflow 面板中，单击 Compound Library。
Compound Library 对话框随即打开。

2. 单击 New，然后从选项列表中选择 Sequence。
New Entry 对话框随即打开。

3. 键入化合物的 Name，然后单击 OK。
软件自动使用提供的名称填充 Compound Library 对话框中的 Compound name 字段。

4. 在 Sequence 字段中键入相应的肽序列。

注释: 该序列可包含自定义元素。请参阅以下章节：Custom Elements。

5. 单击 Chemical formula 字段。

软件将填充 Compound Library 对话框中的下列字段：

• Chemical formula

化合物谱库
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• Polarity

• Isotope Pattern

默认情况下，Adduct 字段填充为双电荷质子化加合物 [M+2H]2+ 或 [M-2H]2–。软件还会
使用相应的信息更新 m/z 字段。

6. 选择采集的 Polarity。
Compound Details 选项卡上的 Isotope Pattern 以及 m/z 和 Adduct 值根据所选的极性
更新。

7. 单击 Experimental Data 选项卡。

8. 执行以下任一操作：

• 要从 wiff 文件添加参考 MS/MS 谱图，请继续以下章节：从 wiff 文件添加参考 MS/MS
谱图。

• 要从 txt 文件添加参考 MS/MS 谱图，请继续以下章节：从 txt 文件添加参考 MS/MS 谱
图。

肽序列命名惯例

表 3-1 肽序列

特点 输入惯例 示例

多链 / 轻链 /

重链

氨基酸上的修饰：侧基 [符号] M[Oxi]

氨基酸上的修饰：C-端基 -[符号] Y-[Ami]

氨基酸上的修饰：N-端基 [符号]- [1Me]-Y

键联 • 每个键合残基上的 [*#]

• 每个连接残基上的数字

S-S 桥：

MYC[*1]PEPC[*1]TIDE

表 3-2 键联

键联类型 惯例 示例

S-S 桥 在桥的两个残基上都添加 [*#] 单链：

MYC[*1]PEPC[*1]TIDE

多链：

LIGHTC[*1]HAIN /

MC[*2]HEAVYC[*1]HAINC[*2
]AD

酯/酰胺桥 向键合残基之一添加 '[O-1]' MYR[*1]PEPD[*1][O-1]TIDE

化合物谱库
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表 3-2 键联 (续)

键联类型 惯例 示例

循环 在 C-端基上添加 '[H]' M[*1]YCPEPCTIDE[*1]-[H]

环：第一个或最后一个指数基
团和端基上连接的残基不是桥
键的组成部分

明确地添加端基 [H]-C[*1]YCPEPCTIDC[*1]-
[OH]

添加寡核苷酸序列
或者，向化合物谱库添加寡核苷酸化合物信息。谱库中的化合物拥有 MS/MS 谱图，将会在处
理过程中用到。

注释: 如果化合物不在谱库中，则用户可以手动将其添加到处理方法中。

序列以文本格式添加。为了捕获各种各样的治疗寡核苷酸修饰和自定义元素，请遵守输入序列
的规则。请参阅以下章节：寡核苷酸序列命名惯例。有关修饰和自定义元素的更详细的列表，
请参阅以下章节：Custom Elements。

1. 在 Workflow 面板中，单击 Compound Library。

2. 单击 New > Oligonucleoide Sequence。
New Entry 对话框随即打开。

3. 键入寡核苷酸序列的 Name，然后单击 OK。

4. 将序列输入 Sequence 表。

注释: 该序列可包含自定义元素。请参阅以下章节：Custom Elements。

5. 单击 Chemical formula 字段以自动更新化学式。

6. （可选）向 Compound Details 选项卡上的字段中键入信息。

7. 单击 Experimental Data 选项卡。

8. 执行以下任一操作：

• 要从 wiff 文件添加参考 MS/MS 谱图，请继续以下章节：从 wiff 文件添加参考 MS/MS
谱图。

• 要从 txt 文件添加参考 MS/MS 谱图，请继续以下章节：从 txt 文件添加参考 MS/MS 谱
图。

寡核苷酸序列命名惯例

寡核苷酸序列可以使用代表碱基的典型单个字母标识符指定：

• 腺嘌呤 (A)

• 胞嘧啶 (C)

• 胸腺嘧啶 (T)

化合物谱库

软件用户指南
RUO-IDV-05-12707-ZH-A

Molecule Profiler 软件
23/127



• 鸟嘌呤 (G)

• 尿嘧啶 (U)

寡核苷酸类型，如脱氧核糖核酸(DNA, d)，核糖核酸(RNA, r)，可以通过在序列的开头添加单
个字母标识符来识别，或者对于混合寡核苷酸类型，可以在碱基之间穿插的单个字母标识符来
识别。

对于包含合成核苷酸的寡核苷酸，例如锁核酸 (LNA)，定义序列时使用每个残基的完整符号。
例如，lA 代表 LNA-A，moA 代表 2'-甲氧基甲基-A。

骨架修饰，例如硫代磷酸化 (HPSO, *)，添加到每个碱基的末尾。

重原子，例如碳-13(/13Cn/)，添加到特定寡核苷酸残基后，其中 n 表示重原子数量。

注释: 在前面的示例中，标记法 "/13Cn/" 向现有的化学式添加了重原子。它不会将核碱基中的
原子替换为重标记。为了定义同位素标记核碱基，需要自定义修饰。

使用斜杠 (/) 作为第一个和最后一个字符，以识别用户定义的自定义修饰。如需添加自定义修
饰，以及有关修饰和相关命名惯例的其他使用案例的示例，请参阅以下章节：Custom
Elements。

表 3-3 寡核苷酸惯例

特点 输入惯例 示例

DNA d dACG T

RNA r rACG U

混合 DNA 和 LNA d, l dACG lT

硫代磷酸化骨架 * dA*C*G* T*

2' 甲氧基甲基 (2'MOE) 糖修
饰

mo moAmoCmoG moT

碳-13 /13Cn/ dACG T/13C2/

自定义残基 // dACG /其他残基/

从 wiff 文件添加参考 MS/MS 谱图
1. 单击 Open wiff File。

Select Data 对话框随即打开。

2. 浏览到相应的位置，选择包含要添加的化合物的谱图的 wiff 文件，然后单击 OK。

注释: 该 wiff 文件必须包含作为母离子的化合物。
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表 3-4 添加参考谱图

文件包含多个母离子 文件包含一个母离子

如果所选 wiff 文件中有多个母离子，则
Select a Spectrum 对话框打开，下列信息显
示在每个可用母离子的 Precursors 表中：

• m/z

• 时间 (min)

• 质量

• 电荷

如果 wiff 文件仅包含一个母离子，则 MS/MS
Spectrum 窗口更新为该谱图。

选中要应用的筛选器对应的复选框。

根据需要选择一个或两个筛选器选项。
Precursors 表更新，仅显示符合指定标准的
行。

软件使用所选母离子的 m/z 和 Charge 以及
实验的碰撞能量在 Compound Library 对话
框的 Spectra 字段中创建唯一信息行。例
如，该字段中显示 Prec(m/z), CE(collision
energy from the experiment),
Charge(Charge)。

谱图的标题包含来自 Compound Information
组中的 Polarity 和 Compound name，后面
是来自 Spectra 字段的信息。

Spectrum Details 包含与所选 MS/MS 谱图
对应的仪器类型、保留时间、电荷和碰撞能
量。这些是只读信息。

选择 Precursors 表中的行。

MS/MS Spectrum 窗口更新为所选母离子的
谱图。

提示! 按住 Ctrl 并单击可选择多个行。如果
选择了多个行，则显示第一个选定母离子的
MS/MS Spectrum。

—

如果选中了 Charge state from 复选框，则
从提供的选项中选择 from 和 to 值。from
值等于 Precursors 表中的最小可用电荷状
态。to 值等于 Precursors 表中显示的最大可
用电荷状态。

—

如果选中了 Quality above 复选框，则在提
供的字段中键入相应的值。

—

单击 OK。 —
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表 3-4 添加参考谱图 (续)

文件包含多个母离子 文件包含一个母离子

对于在 Precursors 表中选择的每一行，软件
使用所选母离子的 m/z 和 Charge 以及实验
的碰撞能量在 Compound Library 对话框的
Spectra 字段中创建唯一信息行。例如，该
字段中显示 Prec(m/z), CE(collision energy
from the experiment), Charge(Charge)。

Spectra 字段中显示的信息和 MS/MS
Spectrum 字段中显示的谱图与在
Precursors 表中选择的第一个行对应。

谱图的标题包含来自 Compound Information
组中的 Polarity 和 Compound name，后面
是来自 Spectra 字段的信息。

Spectrum Details 包含与所选 MS/MS 谱图
对应的仪器类型、保留时间、电荷和碰撞能
量。这些是只读信息。

—

3. （可选）从提供的列表中选择不同的 Spectra。
更新 MS/MS Spectrum 和 Spectrum Details 以显示与该选择相关的信息。

4. 要将谱图保存为化合物的预定义谱图，从提供的列表中选择相应的 Spectra，然后单击
Set as Reference。
- Reference 添加到 Spectra 字段中显示的信息。例如，该字段中显示 Prec (xx.xx),
CE(xx), Charge(xx) - Reference。

5. 单击 Save。

6. 单击 OK。
新化合物保存在谱库中，Compound Library 对话框关闭。

从 txt 文件添加参考 MS/MS 谱图
1. 单击 Open txt File。

Open txt File 对话框随即打开。

2. 浏览到相应的位置，选择 MS/MS txt 文件，然后单击 OK。
Spectrum Details 对话框随即打开。

3. 键入所选谱图的适当信息，然后单击 OK。

软件使用 Precursor mass (m/z)、Collision energy 和 Charge 字段中的信息生成
Compound Library 对话框的 Spectra 字段中的信息。例如，该字段中显示 Prec
(Precursor mass (m/z)), CE(Collision energy), Charge(Charge)。

Spectra 字段中显示的信息和 MS/MS Spectrum 字段中显示的谱图与所选的 txt 文件对
应。
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谱图的标题包含来自 Compound Information 组中的 Polarity 和 Compound name，后
面是来自 Spectra 字段的信息。

Spectrum Details 包含与所选 MS/MS 谱图对应的仪器类型、保留时间、电荷和碰撞能
量。这些是只读信息。

4. （可选）从提供的列表中选择不同的 Spectra。
更新 MS/MS Spectrum 和 Spectrum Details 以显示与该选择相关的信息。

5. 要将谱图保存为化合物的预定义谱图，从提供的列表中选择相应的 Spectra，然后单击
Set as Reference。
- Reference 添加到 Spectra 字段中显示的信息。例如，该字段中显示 Prec (xx.xx),
CE(xx), Charge(xx) - Reference。

6. 单击 Save。

7. 单击 OK。
新化合物保存在谱库中，Compound Library 对话框关闭。

从结果表向化合物谱库添加信息

注释: 此功能仅可用于小分子和肽结果文件。此功能不可用于 ADC 和寡核苷酸结果文件。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 选择 Potential Metabolites 表中的行，单击右键，然后选择 Add to Compound
Library。

注释: 如果所选的行不包含 MS/MS 谱图，则 Add to Compound Library 选项不可用。

6. 在确认页面中单击 OK。

7. 在 Workflow 面板中，单击 Compound Library。
Compound Library 对话框随即打开。添加的代谢物将添加到 Compound name 列表。
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生物转化组 4
生物转化组是常见生物转化的列表。

关于生物转化
用户可以使用随软件一起安装的预定义生物转化组搜索预测的代谢物，也可创建新生物转化
组。例如，用户可能希望为正在分析的每种化合物创建不同的组。安装的生物转化包含在自动
化序列或结构提议期间使用的内嵌信息。

方法特定的生物转化组用作每种方法类型的默认值。例如，肽方法使用生物制剂生物转化组作
为默认值。此生物转化组包含与肽的体内代谢反应最相关的生物转化。

对于寡核苷酸，选择三个预定义转化组之一：

• Oligonucleotide Basic：提供了一个简明的修饰清单，仅限于影响碱基或主链的那些修
饰。

• Oligonucleotide Comprehensive：广泛涵盖在合成、 代谢和存储过程中可能发生的所有
转化。

• Oligonucleotide Metabolites：包含仅关注 转化的完整组中的一个子组。

仔细考虑样本来源，然后选择最有代表性的组。用户可以从默认条目或者通过添加新条目来构
建自己的自定义生物转化组。请参阅以下章节：创建生物转化组和编辑生物转化组。

通过识别化学式的变化或结合两种现有的生物转化来创建自定义生物转化。

自定义生物转化或来自现有组的生物转化可以包含在所创建的任何新生物转化组中。

提示! 访问生物制剂数据时，选择可能性高的生物转化来创建较小的组以便更快地分析数据。

创建生物转化组
1. 在 Workflow 面板中，单击 Biotransformations。

Biotransformations 对话框随即打开。

2. 单击 New。
New Biotransformation Set 对话框随即打开。

3. 在 Working biotransformation set 字段中键入该组的名称。

4. 单击 New Biotransformation。
New Biotransformation 对话框随即打开。

5. 在 Name 字段中键入生物转化的名称。

6. （可选）在 Description 和 Comments 字段中键入与生物转化相关的相应详细信息。

7. 执行以下任一操作：

生物转化组
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表 4-1 创建生物转化组

创建单一生物转化 创建组合生物转化

单击 Single biotransformation。 单击 Combined biotransformation。

在 Formula from 字段中确定结构中将会丢
失的部分。

从 Biotransformation 1 和
Biotransformation 2 字段中各选择一个生
物转化。

在 Formula to 字段中键入生物转化的化学
式。

—

注释: 可用的生物转化是在工作组中已存在的生物转化。

注释: 软件自动计算从生物转化产生的变化，并使用此值填充 Mass shift 字段。

8. 单击 OK。
新生物转化组同时显示在工作生物转化组和源生物转化组表格中。

9. 单击 OK 以保存新生物转化组。
New Biotransformation Set 对话框关闭。

10. 单击 OK。
Biotransformations 对话框关闭。

编辑生物转化组
1. 在 Workflow 面板中，单击 Biotransformations。

Biotransformations 对话框随即打开。

2. 从提供的列表中选择相应的 Set。

3. 单击 Edit。
Edit Biotransformation Set 对话框随即打开，在 Working biotransformation set 字段中
显示选定组的名称。

4. 在 Working biotransformation set 字段中键入相应组的名称。

5. 在工作生物转化组表格中选择所需的行。

6. 单击 Edit Biotransformation。
Edit Biotransformation 对话框随即打开。

7. （可选）在 Name、Description 和 Comments 字段中进行任何必需的更改。

8. （可选）执行以下任一操作：

表 4-2 编辑生物转化组

创建单一生物转化 创建组合生物转化

单击 Single biotransformation。 单击 Combined biotransformation。
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表 4-2 编辑生物转化组 (续)

创建单一生物转化 创建组合生物转化

在 Formula from 字段中确定结构中将会丢
失的部分。

从 Biotransformation 1 和
Biotransformation 2 字段中各选择一个生
物转化。

在 Formula to 字段中键入生物转化的化学
式。

—

注释: 可用的生物转化是在工作组中已存在的生物转化。

9. 单击 OK。
更新后的生物转化组同时显示在工作生物转化组和源生物转化组中。

10. 单击 OK 以保存更改。
Edit Biotransformation Set 对话框关闭。

11. 单击 OK。
Biotransformations 对话框关闭。

删除生物转化组
1. 在 Workflow 面板中，单击 Biotransformations。

Biotransformations 对话框随即打开。

2. 从提供的列表中选择相应的 Set。

3. 单击 Delete。
将打开一条确认消息。

4. 单击 Yes。

5. 单击 OK。
Biotransformations 对话框关闭。
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创建处理方法 5
软件支持四种工作流程：小分子、肽、寡核苷酸和 ADC。

必须创建包含正在研究的样本文件所特有的处理参数的方法，以在感兴趣样本中寻找可能的代
谢物。

选择方法类型

选择参数值

设置通用处理参数

设置化合物特定的处理参数

处理参数
Molecule Profiler 软件中的处理参数包含允许对 wiff 文件进行处理的所有属性和值。处理功能
用于找出和表征代谢物。处理功能还向代谢物指定置信度评分。

使用以下处理参数模板：

• 小分子

• 肽

• 寡核苷酸

• ADC

这些模板代表不同类型的分析所考虑的化合物和工作流程类型。

注释: 添加化合物序列时，请确保序列名称的格式正确。请参阅以下章节：肽序列命名惯例或
寡核苷酸序列命名惯例。

选择方法类型
1. 在 Workflow 面板中，单击 Processing Parameters。

Processing Parameters 工作区随即打开。

2. 单击 New，然后从提供的列表中选择方法类型。

3. 继续执行选择参数值中的第 2 步。
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选择参数值
1. 在 Workflow 面板中，单击 Processing Parameters。

Processing Parameters 工作区随即打开。

2. 在 Processing Parameters 工作区中键入化合物信息。

• 对于小分子和 ADC 工作流程，在 Structure 组中单击 Open Structure，选择目标 mol
文件，然后导入结构。

• 对于肽和寡核苷酸工作流程，在 Sequence 组中键入相应的序列。

提示! 或者，单击 Select From Library 从化合物谱库中选择条目来填充结构或序列。在
该列表中只有与工作流程匹配的条目才可用。请参阅以下章节：从谱库中选择化合物。

3. 确保 Polarity、Charge state 和 Adduct 或 Ion type 适用于该数据集。

寡核苷酸通常在负极性或阴离子模式下采集。对于质量为 10,000 Da 或更小的寡核苷酸，
推荐的电荷范围为 –2 至 –20。建议不要处理质量大于 10,000 Da 的寡核苷酸。

4. 选择寻找可能代谢物时使用的找峰策略。请参阅以下章节：关于找峰策略。

5. 配置与正在处理的化合物无关的参数。请参阅以下章节：通用处理参数。

6. 配置与化合物依存的参数。请参阅以下章节：化合物特定的处理参数。

7. 单击 Save and Close。

8. 在 Save Processing Parameters As 对话框的 Folder 字段中选择方法存储位置。

9. 在 Name 字段中键入方法名称，然后单击 OK。
这样可保存方法，并关闭 Processing Parameters 工作区。

从谱库中选择化合物

1. 在 Workflow 面板中，单击 Processing Parameters。
Processing Parameters 工作区随即打开。

2. 单击 Select From Library。
Select From Library 对话框随即打开。

3. 从 Compound name 字段中的列表选择一种化合物。

注释: 对于小分子和 ADC 处理参数，只有在化合物谱库中识别为结构的条目才会显示在该
列表中。对于肽和寡核苷酸处理参数，只有在化合物谱库中识别为序列的条目才会显示在
该列表中。

4. 单击 OK。
Processing Parameters 工作区更新为所选化合物的信息。

5. 要审核或编辑参考 MS/MS 谱图，单击 Compound-Specific Parameters > Product
Ions and Neutral Losses。

注释: Reference MS/MS Spectrum 窗格填充为所选化合物的 MS/MS 谱图。

6. （可选）如果有多个参考谱图可用，则在列表中浏览，并在适用时选择的不同的谱图。
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注释: 选择不同参考谱图时，Reference MS/MS Spectrum 窗格刷新，并清空子离子和中
性丢失表中的信息。

7. 要配置碎片表，单击 Assign Fragments。

8. 继续执行以下章节的第 5 步：选择参数值。

关于找峰策略

找峰策略是指软件用来寻找感兴趣样本中的可能代谢物的算法。用户可以在 Peak Finding
Strategy 组中选择特定算法来处理数据。

算法 描述

TOF MS

Predicted metabolites • Small molecule：通过此算法，软件可根据选定生物转化组、
预测裂解代谢物或二者的组合搜索代谢物。

• Peptides：通过此算法，软件可根据生物转化组、预测分解代
谢产物或二者的组合搜索代谢物。

• Oligonucleotides：通过此算法，软件可根据生物转化组、预
测分解代谢产物（包括水解裂解、基端 n+1 和内部 n–1 产物）
或二者的组合搜索代谢物。

• ADC：通过此算法，软件可根据生物转化、裂解、抗体碎片或
三者的组合搜索代谢物。

请参阅以下章节：通用处理参数。对于每种方法，使用组合时还
包括在 MS Parameters 选项卡中选择的 Available Adducts。

注释: 建议使用 Predicted metabolites 选项来处理寡核苷酸数
据。

Generic peak finding 通过此算法，软件可搜索意外代谢物。搜索可通过选择 Apply
mass defect filter 或 Apply charge state filter 进一步细化。

控制此算法的参数位于 Chromatographic Data 和 MS
Parameters 选项卡中。请参阅以下章节：通用处理参数。

注释: 建议使用此选项配合 Predicted metabolites 选项来处理寡
核苷酸数据。

Apply mass defect
filter

此筛选器可将搜索结果限制于符合在 Compound-Specific
Parameters 中指定的 Mass Defect 范围内选择的筛选器条件的
峰。选择此筛选器时，只有那些由一般峰发现器找到的、符合指
定标准的代谢物才会被包括在结果中。
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算法 描述

Apply charge state
filter

此筛选器可将搜索结果限制于电荷在 Compound Information 组中
的 Charge state 选项卡范围内的峰。选择此筛选器时，只有那些
由一般峰发现器找到的、符合指定标准的代谢物才会被包括在结
果中。

注释: 建议不要使用此选项来处理寡核苷酸数据。

Mass defect 此算法仅适用于小分子方法。

此算法使用分数质量来筛选数据。化合物、选定生物转化和可能
裂解代谢物均可作用于筛选器，以供用户搜索质量范围内的特定
代谢物。

控制此算法的参数位于 Mass Defect 选项卡中。请参阅以下章
节：化合物特定的处理参数。

Isotope pattern 此算法可搜索同位素模式与母体化合物相似的代谢物。

提示! 如果化合物进行了放射标记，则用户可以通过选择
Compound-Specific Parameters > Isotope Pattern 在
Processing Parameters 对话框中定义同位素富集。

控制此算法的参数位于 Isotope Pattern 选项卡中。请参阅以下章
节：化合物特定的处理参数。

TOF MSMS

注释: 只有当处理参数方法包含参考 MS/MS 谱图时，此算法才有效。参考 MS/MS 谱图可以
来自化合物谱库中的条目，也可以在 Product Ions and Neutral Losses 选项卡上手动添加。
请参阅以下章节：化合物特定的处理参数。

Find characteristic
product ions

软件使用此算法搜索 IDA 数据以及 SWATH 采集数据中包含母体
化合物典型子离子的代谢物。

通过此算法，用户可以搜索全部或有限数量的已识别离子。

控制此算法的参数位于 Product Ions and Neutral Losses 选项卡
中。请参阅以下章节：化合物特定的处理参数。

All specified ions 选择此选项时，搜索所有已识别离子。例如，如果已识别四种子
离子，然后搜索包含所有这些离子的峰，则仅将完全匹配的项识
别为可能代谢物。

At least __ ions 选择此选项时，仅搜索在 Product Ions and Neutral Losses 选项
卡中选择的离子。例如，如果搜索包含至少两种离子的峰，则所
选离子中必须有至少两种离子出现在代谢物的 MS/MS 谱图中，
才能将该峰视为代谢物。
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算法 描述

Find characteristic
neutral losses

软件使用此算法搜索 IDA 数据以及 SWATH 采集数据中包含母体
化合物中性丢失的代谢物。此算法不适用于肽和寡核苷酸工作流
程。

通过此算法，用户可以搜索全部或有限数量的丢失。例如，如果
已识别四种中性丢失，然后搜索包含所有这些丢失的峰，则仅将
完全匹配的项识别为可能代谢物。如果要搜索包含至少两种丢失
的峰，则所选丢失中必须有至少两种出现在代谢物的 MS/MS 谱
图中，才能将该峰视为代谢物。

控制此算法的参数位于 Product Ions and Neutral Losses 选项卡
中。请参阅以下章节：化合物特定的处理参数。

All specified losses 选择此选项时，搜索所有代谢物并报告所有中性丢失。

At least __ losses 选择此选项时，仅搜索在 Product Ions and Neutral Losses 选项
卡中选择的丢失。例如，如果已识别四种中性丢失，并后搜索包
含所有这些丢失的峰，则仅将完全匹配的项识别为可能代谢物。
如果要搜索包含至少两种丢失的峰，则所选丢失中必须有至少两
种出现在代谢物的 MS/MS 谱图中，才能将该峰视为代谢物。

Consider internal
neutral losses

这是 SWATH 采集数据特有的算法。

只有选择了至少两种中性丢失时，此策略才有效。内部中性丢失
是两种中性丢失化学式之间的差值。请注意，一个中性丢失化学
式需要是另一个中性丢失化学式的子集，“按内部中性丢失查找”才
能生效

Isotope pattern
(SWATH Only)

这是 SWATH 采集数据特有的算法。

碎片同位素模式与 Compound-Specific Parameters 中 Product
Ions and Neutral Losses 选项卡上的表格中所选碎片同位素模式
匹配的母离子标记为代谢物。用户必须在 Isotope Pattern 列中
选择一个或多个碎片同位素化学式复选框。实验碎片同位素模式
与理论碎片同位素模式的匹配度必须在 MS/MS Parameters 选项
卡上指定的 MS/MS m/z 公差以及强度公差范围内，才能将峰视为
代谢物。

通用处理参数

通用参数是指与正在处理的化合物无关的设置。下面的每个选项卡各自管理通用参数：

通用参数

小分子 肽 寡核苷酸 ADC
Biotransformations 选

项卡
Biotransformations 选

项卡
Biotransformations 选

项卡
Biotransformations 选

项卡
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Chromatographic
Data 选项卡

Chromatographic
Data 选项卡

Chromatographic
Data 选项卡

Chromatographic
Data 选项卡

MS Parameters 选项
卡

MS Parameters 选项
卡

MS Parameters 选项
卡

MS Parameters 选项
卡

MS/MS Parameters
选项卡

MS/MS Parameters
选项卡

MS/MS Parameters
选项卡

MS/MS Parameters
选项卡

Formula Prediction 选
项卡（小分子和 ADC

方法）

Confirmation Scoring
选项卡

Confirmation Scoring
选项卡

Formula Prediction 选
项卡（小分子和 ADC

方法）

Confirmation Scoring
选项卡

Confirmation Scoring
选项卡

Biotransformations 选项卡

识别包含预期生物转化的生物转化组。软件包括预定义的生物转化组。要创建自定义生物转化
组，请参阅以下章节：创建生物转化组。

参数 描述

Select Set 从数据库中选择要用于处理的不同生物转化组。

选择此选项时，软件可能显示下面的警告：“The selected
biotransformation set might no longer exist in the
biostransformations database.”。这是因为所选的生物转化组已

保存到处理参数文件。在 Biotransformations 工作区中对生物转化组进行
的后续更改不会保存到处理参数文件。

要使用保存的生物转化组重新处理，单击 OK，然后单击
Biotransformations 对话框中的 Cancel。要使用新生物转化组更新处理参
数文件，请执行此操作：

1. 单击 OK。

2. 选择生物转化组。

随即显示消息：“If you select this new
biotransformation set, you might not be able to
re-select the existing set.Do you want to
continue?

3. 单击 OK。

Chromatographic Data 选项卡

参数 描述

Chromatographic Peak
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参数 描述

Retention time
window

指定搜索可能代谢物的保留时间范围。保留时间 (RT) 窗口的大小与处理
时间成正比。

指定一个大于 0.00 min 的值以排除色谱柱的空隙容积。

to 值必须大于 from 值。

我们建议对所有工作流程设置 RT 窗口，因为宽 RT 范围可以显著地增加
处理时间。范围高度依赖正在分析的实验。检查每个实验的 RT 窗口。我
们建议开始时间比 0.00 min 稍大，结束时间比感兴趣峰稍晚，或者在方
法进入梯度的高洗脱或清洗相时。

MS data 指定设置 XIC 宽度的方法。
• XIC width：指定处理时需要考虑的提取离子色谱图的宽度。

• Automatic：软件根据所选数据计算最佳宽度。

建议对寡核苷酸工作流程使用 Automatic 设置。

注释: 如果在处理 SWATH 采集数据时已选择此选项，则应用 XIC width
选项。

LC peak
separation

确定如何对密集洗脱峰进行积分。此参数还用于处理有明显拖尾的色谱
峰。

如果存在密集洗脱峰，则将此参数设置为较低的值。较低的设置可单独地
对待各个峰，而不是将其视为一个峰。

TOF MS

Minimum peak
width

排除宽度低于此值的色谱峰。

设置较低的值以包含窄峰。

Minimum peak
intensity

不考虑低于指定 TOF MS 强度水平的色谱峰。

存在高噪声色谱数据时使用。通过设置刚好高于噪声水平的阈值，可以拒
绝可能是噪声结果的峰。

在 Molecule Profiler 软件或查看器软件（例如，SCIEX OS 中的 Explorer
工作区）中处理数据之前，请检查峰宽。使用检查的所有峰的总平均值计
算最小峰宽。

对于包含 TOF MS 或 IDA 实验的寡核苷酸方法，建议设置为 50 cps。

Use smoothing 通过消除噪声内的强度变化来区分峰与噪声。

存在高噪声色谱数据时选择。

建议对寡核苷酸工作流程使用此选项。
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参数 描述

Sample-control
offset

对齐 MS 样本和对照品色谱图。在处理过程中，软件会在比较对照品与样
本之前偏移所有对照品。

Sample/control
ratio

指定在与对照品进行比较时样本峰必须大多少倍才能视为代谢物。

TOF MS/MS

Minimum peak
intensity

仅在通过 MS/MS 找峰算法处理 SWATH 采集数据使用此参数。处理 IDA
数据时不使用此参数。

不考虑低于指定 TOF MS/MS 强度水平的色谱峰。

存在高噪声色谱数据时使用。通过设置刚好高于噪声水平的阈值，可以拒
绝可能是噪声结果的峰。

Analog data

Wavelength (UV
only)

选择确认可能代谢物时使用的波长。

Time offset
from MS

对齐 MS 和模拟色谱数据。在处理过程中，软件会在比较模拟数据与 MS
数据之前偏移所有模拟数据。

注释: MS 和模拟色谱数据还可以在 Analog Interpretation 工作区中进行对
齐后处理。请参阅以下章节：更改保留时间偏移。

LC peak
separation

确定如何对密集洗脱峰进行积分。此参数还用于处理有明显拖尾的色谱
峰。

如果存在密集洗脱峰，则将此参数设置为较低的值。较低的设置可单独地
对待各个峰，而不是将其视为一个峰。

Minimum peak
width

排除宽度低于此值的色谱峰。

设置较低的值以包含窄峰。

Minimum peak
intensity

不考虑低于指定强度水平的色谱峰。

存在高噪声色谱数据时使用。通过设置刚好高于噪声水平的阈值，可以拒
绝可能是噪声结果的峰。

Use smoothing 通过消除噪声内的强度变化来区分峰与噪声。

存在高噪声色谱数据时选择。

Sample-control
offset

对齐 MS 样本和对照品色谱图。在处理过程中，软件会在比较对照品与样
本之前偏移所有对照品。
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MS Parameters 选项卡

参数 描述

m/z Tolerance

MS m/z
tolerance

指定用于确定 MS 谱图中的峰的范围。此范围内的所有质量都将视为一个
唯一峰。为了使指定实验化学式的峰被视为可能代谢物，峰的质量准确度
必须在指定的公差范围内。

此参数高度依赖仪器的校准状态。对于校准为 ±3 ppm 以内的仪器，建议
对包含 TOF MS 或 IDA 实验的寡核苷酸方法使用值 10 ppm。

Minimum MS
peak intensity

为 MS 峰强度指定最小谱图阈值。不考虑强度低于指定谱图阈值的 MS
峰。

根据谱图中的噪声水平设置该值。

Isotope Pattern Tolerances

MS m/z
tolerance

指定应用于代谢物同位素模式的公差。只有同位素 m/z 偏移值在此公差范
围内的峰才会被视为匹配项。

对于包含 TOF MS 或 IDA 实验的寡核苷酸方法，建议使用值 10 mDa。

Intensity
tolerance

指定在 Compound-Specific Parameters 中的 Isotope Pattern 选项卡上定
义的同位素强度相对公差。为进行匹配，两个峰的强度比值必须等于该公
差内的预期比值。

对于包含 TOF MS 实验的寡核苷酸方法，建议使用值 20%。

Minimum Score （寡核苷酸方法）指定观察到的代谢物同位素模式与预期同位素模式相比
的最小匹配公差（以百分比为单位）我们建议从值 0% 开始，然后根据需
要增大数值以消除确认的假阳性识别。

Limits

Maximum
number of
unexpected
metabolites

选择可被识别为可能代谢物的意外峰最大数量。

此设置影响一般峰发现器可识别的峰最大数量。一般峰发现器可与预测代
谢物峰发现器相互作用。例如，如果为复杂样本选择了较小的生物转化
组，则意外代谢物的最大数量将会很高，因此将需要增大此设置。通常，
为了处理杂质寡核苷酸样本，建议使用设置值 100。对于更复杂的样本，
应当增大此数值。

Mass range
window (m/z)

限制用于查找可能代谢物的质量范围。

Generic LC/MS Peak Finding
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参数 描述

Perform
background
subtraction

指定是否执行背景减除。选择此选项可在 LC/MS 色谱图中的背景水平较
高时删除背景离子。

对于包含 TOF MS 和 TOF MS/MS 实验的寡核苷酸方法，建议不要使用
此选项。

Available Adducts（小分子方法）

所有可支持加合物的列表，基于在 Compound Information 组中定义的电荷范围。

Use 指示加合物是否应包含在搜索中。

__ adduct(s)
selected

（只读）指示已在 Available Adducts 表的 Use 列中选择的加合物的数
量。

Advanced Ion Types（ADC、肽和寡核苷酸方法）

Use 指示离子是否应包含在搜索中。

__ adduct(s)
selected

（只读）指示已在 Advanced Ion Types 表的 Use 列中选择的离子的数
量。

MS/MS Parameters 选项卡

参数 描述

MS/MS Finding

MS/MS m/z
tolerance

指定用于确定 MS/MS 谱图中的峰的范围。MS/MS m/z 公差是在 MS/MS
谱图中发现的碎片峰与在 Compound-Specific Parameters 的 Product
Ions and Neutral Losses 选项卡上指定的所选碎片或中性丢失值匹配时必
须达到的公差，这样才能将相应的母离子峰视为可能代谢物。

对于包含 TOF MS/MS 或 IDA 实验的寡核苷酸方法，建议使用值 10
mDa。

Minimum
MS/MS peak
intensity

不考虑强度低于指定谱图阈值的 MS/MS 峰。

根据谱图中的噪声水平设置该值。

MS/MS Isotope Finding

MS/MS m/z
tolerance

指定用于确定 MS/MS 谱图中的峰的范围。为了将 MS/MS 谱图中的峰视
为匹配项，两个同位素峰之间的质量差必须等于此公差内的预期差。

使用所选的同位素模式（仅限 SWATH）找峰策略处理 SWATH 采集数据
时，使用 MS/MS m/z 公差。

对于包含 TOF MS/MS 或 IDA 实验的寡核苷酸方法，建议使用值 10
mDa。
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参数 描述

Intensity
tolerance

指定 Compound-Specific Parameters 的 Product Ions and Neutral
Losses 选项卡上所选 IP 单元格中定义的选定碎片化学式同位素强度的相
对公差。为进行匹配，两个峰的强度比值必须等于该公差内的预期比值。
此参数还定义可视为模式组成部分的最小同位素。例如，如果强度公差为
10%，则可影响质量模式的最小同位素必须达到 100% 定义峰的 10% 或
更高。

使用所选的同位素模式（仅限 SWATH）找峰策略处理 SWATH 采集数据
时，使用 Intensity tolerance。

对于包含 TOF MS/MS 或 IDA 实验的寡核苷酸方法，建议使用值 20%。

Source of Reference MS/MS Spectrum

Control 为感兴趣化合物选择参考谱图。该谱图可以从各种位置选择。

默认情况下已选择 Selected reference spectrum。

我们建议在使用自动结构或序列生成功能时选择 Selected reference
spectrum 选项。

Sample

Selected
reference
spectrum

MS/MS Spectrum

Use advanced
MS/MS filter

此筛选器专门用于 SWATH 采集数据。此筛选器使用的算法包括 PCVG，
它用于将 MS/MS 谱图中的碎片指定给 SWATH 采集数据的特定母离子，
只有能够确信地指定给母离子的碎片才会显示在 MS/MS 谱图中，具体取
决于滑块的位置（Comprehensive 或 Confident）。

Similarity and Fragment Interpretation

MS/MS m/z
tolerance

选择用于比较参考 MS/MS 谱图与代谢物 MS/MS 谱图的质量准确度公
差。在 Interpretation 表中指定碎片时也使用此参数。所指定碎片的质量
准确度必须在提供的 MS/MS m/z 公差范围内。

对于包含 TOF MS/MS 或 IDA 实验的寡核苷酸方法，建议使用值 10
ppm。

Minimum
signal-to-noise
ratio

选择用于比较参考 MS/MS 谱图与代谢物 MS/MS 谱图的信号与意外噪声
的最小比率。在 Interpretation 表中指定碎片时也使用此参数。所指定碎
片的信噪比必须高于提供的最小信噪比。

Fragment Interpretation Options（小分子和肽方法）

Number of
fragment peaks
selected for
assignment

（小分子方法）指定将为指定操作选择的 MS/MS 碎片数量。根据峰强度
选择峰（先选择强度较高的峰）。

Break aromatic
rings

（小分子方法）断开形成芳香环的键。
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参数 描述

Maximum
number of
bonds to break

（小分子方法）指定在为解读操作指定 MS/MS 碎片时要断裂的键最大数
量。

Maximum
number of C-C
bonds to break

（小分子方法）指定在为解读操作指定 MS/MS 碎片时要断裂的 C-C 键最
大数量。

Fragment
Types

（肽方法）确定碎片类型。可以选择多个类型。

Maximum
bonds to break

（肽方法）指定要断裂的键最大数量。

Break linkages （肽方法）断裂肽或寡核苷酸序列中的键联。

Formula Prediction 选项卡（小分子和 ADC 方法）

参数 描述

Search Constraints

Elements from

Elements to

指定起始元素，以供软件用来为可能代谢物提议化学式。

Isotope Pattern Tolerances

MS m/z
tolerance

当软件确定了提议化学式的理论预测同位素模式后，此参数可限制与代谢
物的同位素模式进行比较时同位素之间的允许质量差值。

Intensity
tolerance

当软件确定了提议化学式的理论预测同位素模式后，此值可限制与代谢物
的同位素模式进行比较时同位素峰强度的允许差值。

Ranking

Contribution 指定在结果中应提供基于 MS 谱图还是基于 MS/MS 谱图的化学式。

Automatically
weight MS/MS

选择此项以将对数刻度应用于 MS/MS 加权。

Rings and Double Bonds

RDB from

RDB to

识别可能代谢物的提议化学式中的环键和双键范围。

如果提议化学式的环键和双键数量不在指定的范围内，则将不为代谢物考
虑该化学式。

最小值必须小于最大值。

Element Ratios
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参数 描述

Oxygen/
phosphorus
count

指定提议化学式中必须出现的氧-磷分子的范围。

此参数同时适用于 MS 和 MS/MS 化学式。

Oxygen/sulphur
count

指定提议化学式中必须出现的氧-硫分子的范围。

此参数同时适用于 MS 和 MS/MS 化学式。

Confirmation Scoring 选项卡

在感兴趣样本中找到可能代谢物时，软件会指定一个确认评分，指示找到的峰是代谢物的可能
性。该评分与用来寻找代谢物的算法无关，取决于各种属性。

注释: 对于寡核苷酸方法，建议 Isotope pattern 的值为 100，所有其他参数的值为 0。

参数 描述

Mass defect （小分子方法）指示代谢物的质量亏损与母体化合物、可能裂解代谢物或
第 II 阶段代谢物的质量亏损的匹配程度。

注释: 此属性不用于 ADC、肽和寡核苷酸数据的总确认评分的计算。

Isotope pattern （小分子和 ADC 方法）指示代谢物是否包含与母体化合物相似的同位素
模式。此属性的评分为 0 到 100。

（寡核苷酸方法）指示代谢物是否包含与预期同位素模式相似的同位素模
式。此参数对于筛选假阳性结果非常有用。建议数值为 100。

MS/MS 指示 MS/MS 谱图与参考谱图的接近程度。仅在参考谱图可用时，此属性
才适用。

MS/MS 分数有两个组成部分：

• 质量：区分谱峰与背景噪声的能力的衡量指标。

• 相似性：软件计算 MS/MS 谱图与参考谱图的接近程度，包括根据已知
生物转化发生偏移的子离子。

注释: 如果仅处理 TOF MS 数据，则将此参数设置为 0。

Mass accuracy 指示找到的 m/z 值与预期 m/z 值的接近程度。此属性仅应用于预测的代谢
物。

Total
confirmation
score

（只读）四个属性值的总和。
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提示! 在 Scoring 表中键入 0 以在评分时忽略特定属性。

化合物特定的处理参数

化合物特定的处理参数是指取依赖于正在处理的化合物的设置。下面的每个选项卡各自管理化
合物特定的参数。

化合物特定的参数

小分子 肽 寡核苷酸 ADC
Cleavage Metabolites
选项卡（小分子和

ADC 方法）

Catabolites 选项卡
（肽方法）

Catabolites 选项卡
（寡核苷酸方法）

Cleavage Metabolites
选项卡（小分子和

ADC 方法）

Mass Defect 选项卡
（小分子方法）

Isotope Pattern 选项
卡

Isotope Pattern 选项
卡

Isotope Pattern 选项
卡

Isotope Pattern 选项
卡

Product Ions and
Neutral Losses 选项

卡

Product Ions and
Neutral Losses 选项

卡

Product Ions and
Neutral Losses 选项

卡

Product Ions and
Neutral Losses 选项

卡

抗体详情

Cleavage Metabolites 选项卡（小分子和 ADC 方法）

确定母体化合物的可能裂解代谢物。该方法必须包含结构，然后软件才能生成可能裂解代谢物
的列表。

参数 描述

Potential Compound Cleavages

Maximum
bonds to break

指定要断裂的键最大数量。

Break ring
bonds

断开形成环的键。

Only break C-N
bonds

仅断开 C-N 键。

Cleavages
selected

指示已在可能化合物裂解表中选择的裂解的数量。由软件自动生成。

Catabolites 选项卡（肽方法）

确定母体化合物的可能水解裂解。该方法必须包含肽序列，然后软件才能生成可能的水解分解
代谢产物的列表。
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参数 描述

Potential Hydrolytic Cleavages

Max. peptide
bonds to break

指定要断裂的肽键最大数量。

Max. cross-
links to break

指定要断裂的交联最大数量。

Min. AA count 指定分解代谢产物中的氨基酸最小数量。

Catabolites
selected

（只读）指示已在可能水解裂解表中选择的分解代谢产物的数量。

Catabolites 选项卡（寡核苷酸方法）

确定母体化合物的可能水解裂解。该方法必须包含肽序列，然后软件才能生成可能的水解分解
代谢产物的列表。

参数 描述

Potential Hydrolytic Cleavages

Max. bonds to
break

指定仅可随寡核苷酸骨架断裂的键的最大数量，包括 H2PO3 损失。关于
核碱基和糖损失，请参阅以下章节：Biotransformations 选项卡。

Min.
Nucleotides

指定用于生成可能分解代谢产物和水解裂解的核苷酸最小数量。

Include
terminus n+1
sequences

指定是否搜索基端 n+1 杂质。

Include internal
n-1 sequences

指定是否搜索内部 n-1 杂质。

Catabolites
selected

（只读）指示已在可能水解裂解表中选择的分解代谢产物的数量。

Mass Defect 选项卡（小分子方法）

分析复杂的生物样本时，这些过滤可帮助除去背景干扰。

参数 描述

Mass Defect Filters

Filters selected 指示已在质量亏损过滤表中选择的质量亏损过滤的数量。由软件
自动生成。

Filters

Parent 默认选中。

Glucuronidation 默认选中。
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参数 描述

Bis-Glucuronidation 默认选中。

Glutathione 默认选中。

Sulphate 默认选中。

Isotope Pattern 选项卡

参数 描述

Isotope Pattern 显示 Isotopes 表中所列信息的示意图。

（寡核苷酸方法）显示特定电荷状态下寡核苷酸的同位素分布示意图。要
更改电荷状态，在 Compound Information 中选择不同的 Ion type。

Isotopic
Enrichment

指定在母体化合物的化学式中将使用的原子同位素富集。

注释: 要为 ADC 或小分子方法添加同位素元素，导入包含该同位素的 mol
文件。

注释: 要为包含富集原子的肽和寡核苷酸化学式更改同位素富集，请参阅
以下章节：编辑肽和寡核苷酸化学式的同位素富集。

Isotopes 根据母体化合物的化学式和同位素富集（如果适用），显示最大强度的同
位素。

Isotope Pattern
Intensity Cufoff
for Metabolite
XICs (%)

（寡核苷酸方法）指定在峰面积计算期间对 XIC 提取所考虑的每种同位素
应用的截止值（以强度百分比为单位）。强度低于截止值的同位素在表中
显示为红色。

Product Ions and Neutral Losses 选项卡

参数 描述

Reference
MS/MS
Spectrum

识别在选择子离子和中性丢失以匹配可能代谢物的 MS/MS 时使用的谱
图。最佳来源是在与感兴趣样本相似的条件下采集的样本的数据文件。

该谱图可以从以下两个位置之一选择：

• wiff 文件

• 化合物谱库

Filters

m/z From __ to
__

定义在填充子离子和中性丢失表时考虑的质量范围。只有处在所选范围内
的碎片才会显示在子离子和中性丢失表中。

Charge state
From __ to __

定义在填充子离子和中性丢失表时考虑的电荷状态范围。只有电荷处在所
选范围内的碎片才会显示在子离子和中性丢失表中。
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参数 描述

Only show
product ions
above (%)

定义要包含在子离子和中性丢失表中的子离子最小阈值。不考虑低于指定
强度的子离子。

Mass accuracy
within (mDa)

只有质量准确度处在指定值范围内的碎片才会显示在子离子和中性丢失表
中。

Add product
ions, neutral
losses from
Phase II
metabolites

（小分子和 ADC 方法）包括子离子和中性丢失表中的第 II 阶段代谢物的
子离子和中性丢失。

注释: 对筛选器进行了所有必需的更改后，单击 Assign Fragments 以更新子离子和中性丢失
表。

抗体详情

注释: 这些化合物特定的参数仅适用于 ADC 方法。

参数 描述

Protein
Sequence

抗体的蛋白质序列。

Enzyme 用于消化蛋白质的酶。

Break disulfide
bonds

选中此复选框时，会使二硫键断裂。

Site of
conjugation

抗体中可与药物分子共轭的氨基酸。

Type of
conjugation

在药物分子与抗体的共轭中涉及的化学作用。

Max. AA count 在消化之后，可视为可能碎片的氨基酸最大数量。

Selected
fragments

由软件自动生成。指示已在表中选择的碎片的数量。

编辑肽和寡核苷酸化学式的同位素富集

前提条件

必须创建自定义氨基酸，可以带有或不带自定义氨基酸修饰。请参阅以下章节：创建自定义
氨基酸和创建自定义氨基酸修饰。自定义氨基酸或自定义氨基酸修饰必须包含到少一种富集
同位素。
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1. 在 Workflow 面板中，单击 Processing Parameters.
Processing Parameters 工作区随即打开。

2. 单击 New > Peptides 或 New > Oligonucleotide

注释: 或者，从化合物谱库中选择条目来填充序列。

3. 在提供的字段中键入自定义氨基酸或寡核苷酸的 Compound name。

4. 键入自定义氨基酸或寡核苷酸的 Sequence 信息。序列必须包括至少一种富集同位素。

5. 单击 Chemical formula 字段。

Chemical formula 字段和 m/z 值填充为与自定义氨基酸相关的信息。

提示! 序列上方会显示  图标。将光标悬停在该图标上以查看所用自定义氨基酸的
Symbol 和 Residue Formula。

6. 单击 Compound-Specific Parameters > Isotope Pattern。
在 Isotopic Enrichment 表中，自定义氨基酸的残基化学式显示在 Element 列中，100 显
示在 Enrichment % 列中。

7. 根据需要修改 Enrichment % 值。

8. 单击 Save and Close。
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搜索可能分子 6
Batch 工作区用于同时处理多个样本文件。批次表可以手动填充，也可以导入现有批次以填充
该表。

1. 要手动准备批次，请继续以下章节：创建批次。

2. 要打开现有批次，请继续以下章节：打开批次。

3. 要导入现有批次，请继续以下章节：导入批次。

关于 Batch 工作区
使用 Batch 工作区创建样本批次以进行处理。

图 6-1 Batch 工作区

搜索可能分子

软件用户指南
RUO-IDV-05-12707-ZH-A

Molecule Profiler 软件
49/127



项目 描述

1 菜单栏。包含以下按钮：
• Options：打开 Batch Processing Options 对话框，用户可从中指定与

批次相关的选项。请参阅以下章节：批次处理选项。

• New：单击后保存批次。仅在样本添加到 Sample/Controls 字段后可
用。

• Open：打开 Open Processing Batch 对话框，用户可从中选择要打开
的现有批次。请参阅以下章节：打开批次。

• Import：打开 Batch Importer 对话框，用户可从中选择要导入的 Excel
文件。请参阅以下章节：导入批次。

• Save：保存当前打开的批次文件。自动替换现有版本。仅在修改了批
次信息后可用。

• Save As：保存当前打开的批次文件。用户可以为批次文件指定新名
称。

2 Find Metabolites 按钮。开始处理批次。

3 Sample/Controls 列。Sample 按钮可打开 Select Data 对话框，用户可
从中选择感兴趣样本。Controls 按钮可打开 Select Data 对话框，用户可
从中选择相应的对照样本。每个样本可以选择最多五个对照品。

4 Folder 列。提供存储处理参数和结果的文件夹位置的列表。

5 Processing Parameters 列。提供可用于处理感兴趣样本的处理参数的
列表。只有存储在所选 Folder 中的处理参数可供选择。

6 Apply Options 列。默认选中。选择后，对批次中的样本和对照样本应用
在 Batch Processing Options 对话框中选择的所有 Auto Assign 和 Report
选项。选项包括：

• 取消选择 Apply Options 复选框可取消选择所有已选中的复选框。

• 取消选择特定样本复选框。

• 选择特定样本复选框。

请参阅以下章节：批次处理选项。

注释: Auto Assign 选项不适用于寡核苷酸工作流程。

7 Results File 列。用户指定的结果文件名称。

指定批次选项
请参阅以下章节：批次处理选项。

1. 在 Workspace 面板中，单击 Batch。
Batch 工作区随即打开。
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2. 单击 Options。
Batch Processing Options 对话框随即打开。

3. （小分子、肽和 ADC 工作流程）在 Auto Assign 选项卡上：

• 选中每个适用的选项对应的复选框。

• 为所选的每个选项键入合适的值。

4. 在 Report 选项卡上：

• 选中每个适用的选项对应的复选框。

• 为所选的每个选项键入合适的值。

5. 单击 OK。
批次选项将随批次一起保存。

批次处理选项

选项 描述

Auto Assign

注释: 自动指定选项彼此独立。它们应视为“或”条件。所选的一个或多个选项必须满足指定的
标准。

注释: 自动指定选项不适用于寡核苷酸样本。

Assign Structures or
Sequences

为满足选定的选项标准的代谢物提议可能的结构或序列。取决于
使用的数据类型和处理参数（即它是小分子还是肽）。

注释: 可以选择多个选项。

Metabolites with peak
areas above (%)

为 XIC 峰面积高于指定值的代谢物提议可能的结构或序列。

Metabolites with analog
peak areas above (%)

为模拟峰面积高于指定值的代谢物提议可能的结构或序列。

Metabolites with MS/MS
quality above

为 MS/MS 质量高于指定值的代谢物提议可能的结构或序列。

此选项不适用于寡核苷酸工作流程。

Report

注释: 报告选项相互依存。它们应视为“与”条件。所选的全部选项都必须满足指定的标准。

Report metabolites with
assigned structures or
sequences

对于已指定了结构或序列的任何代谢物，在 Potential
Metabolites 表的 Report 列中显示一个选取标记。

Report metabolites with
peak areas above (%)

对于峰面积高于指定值的任何代谢物，在 Potential Metabolites
表的 Report 列中显示一个选取标记。
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选项 描述

Report metabolites with
analog peak areas
above (%)

对于模拟峰面积高于指定值的任何代谢物，在 Potential
Metabolites 表的 Report 列中显示一个选取标记。

Report metabolites with
scores above (%)

对于评分高于指定值的任何代谢物，在 Potential Metabolites 表
的 Report 列中显示一个选取标记。

创建批次

注释: 每行只能处理一个样本。每个样本最多可以选择五个对照品。但是，对照品不是进行处
理所必需的项。

1. 在 Workspace 面板中，单击 Batch。
Batch 工作区随即打开。

提示! 选择 Open 选项以找到以前保存的批次文件。请参阅以下章节：打开批次。

2. 通过下面的操作添加 MS 样本：

a. 在批次表的第一个可用行中，单击 Sample。
Select Data 对话框随即打开。

b. 单击 Browse，然后导航到相应的源文件夹。

c. 在 Available 字段中选择包含感兴趣样本的 wiff 文件和进样，然后单击 >>。
样本信息会显示在 Selected 字段中。

3. （可选）通过下面的操作添加模拟样本：

提示! 如果采集了模拟数据，则选中 Use analog data 复选框以在添加 MS 样本时自动添
加模拟数据。

a. 在批次表的第一个可用行中，单击 Use analog data。

b. 打开 Analog Sample 选项卡。

c. 单击 Browse，然后导航到相应的源文件夹。

d. 在 Available 字段中选择模拟样本，然后单击 >>。
样本信息会显示在 Selected 字段中。

4. 单击 OK。
批次表中的选定行的 Sample/Controls 字段将会填充样本信息。

5. （可选）通过下面的操作添加 MS 对照品：

a. 在批次表的第一个可用行中，单击 Control。
Select Data 对话框随即打开。

b. 单击 Browse，然后导航到相应的源文件夹。

c. 在 Available 字段中选择包含对照品的 wiff 文件和进样，然后单击 >>。
样本信息会显示在 Selected 字段中。
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d. 继续执行以下步骤添加模拟对照品，或者单击 OK 关闭此对话框。

6. （可选）通过下面的操作添加模拟对照品：

a. 在批次表的第一个可用行中，单击 Use analog data。

b. 打开 Analog Sample 选项卡。

c. 单击 Browse，然后导航到相应的源文件夹。

d. 在 Available 字段中选择模拟样本，然后单击 >>。
样本信息会显示在 Selected 字段中。

e. 单击 OK。
批次表中的选定行的 Sample/Controls 字段将会填充样本信息。

7. 在 Folder 列中，选择用于保存处理参数和结果文件的文件夹。

8. 在 Processing Parameters 列中，选择处理参数文件。

提示! 要查看处理参数文件，单击 P。根据需要更改参数，然后单击 Save and Close 进
行保存。

9. 在 Results File 列中，键入将要存储结果的文件的名称。

10. 对批次中的每个行重复第 2 步至第 9 步。

注释: 在每个批次中可以处理的最大行数为 200 个。

提示! 为了便于创建批次，可以复制粘贴或删除行。请参阅以下章节：复制和粘贴批次行
或清除批次行。

复制和粘贴批次行

使用复制和粘贴选项编辑批次。

1. 在批次表中，选择要复制的行。

2. 单击右键，然后选择 Copy Batch Row。

3. 选择所粘贴信息的目标行。

4. 单击右键，然后选择 Paste Batch Row。

注释: 目标行中的任何现有信息都将被覆盖。

清除批次行

创建批次时，可以清除样本信息行。

1. 在批次表中，选择要清除的行。

2. 单击右键，然后选择 Clear Batch Row。
所有数据都将从所选的行中删除。
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打开批次
1. 在 Workspace 面板中，单击 Batch。

Batch 工作区随即打开。

2. 单击 Open。
Open Processing Batch 对话框随即打开。

3. 选择批次文件，然后单击 OK。

4. 执行以下任一操作：

• 如果批次完整，则继续以下章节：提交批次。

• 如果批次不完整，则继续以下章节：创建批次。

导入批次
1. 在 Workspace 面板中，单击 Batch。

2. 单击 Import。
Batch Importer 对话框随即打开。

3. 单击 Browse。
Open excel file 对话框随即打开。

4. 导航到并选择相应的 Excel 文件。

注释: 应使用随软件一起分发的示例模板 (BatchImportTemplate.xlsx) 创建 Excel 文件。在
安装期间，该模板安装在下面的位置：
C:\ProgramData\SCIEX\Molecule Profiler\Batch Import Templates 文件

夹。

5. 单击 Open。
Target batch file 字段填充为导入的 Excel 文件的名称。如果需要，可以修改这些信息。

6. 执行以下任一操作：

• 要将所选 Excel 文件转换成 Molecule Profiler 软件批次并在 Batch 工作区中打开批
次，单击 Convert and Open，然后继续执行第 7 步。

• 要将所选 Excel 文件转换成随后可在 Batch 工作区中打开的 Molecule Profiler 软件批
次，单击 Convert，然后继续执行第 7 步。

• 要取消导入，单击 Close。

7. 执行以下任一操作：

• 如果选择了 Convert and Open 选项，并且 Excel 文件中引用的所有处理参数（方法
文件）和文件夹都存储在正确的位置，则继续以下章节：提交批次。

• 如果选择了 Convert 选项，并且 Excel 文件中引用的所有处理参数（方法文件）和文
件夹都存储在正确的位置，则继续以下章节：保存批次。

• 如果选择了 Convert and Open 选项或 Convert 选项，并且显示确认对话框，则继续
执行第 8 步。
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图 6-2 Confirmation 对话框

8. 执行以下任一操作：

• （小分子工作流程）要自动创建所需的方法文件，请继续执行第 9 步。

注释: Method Generator 不能用于肽、寡核苷酸或 ADC 工作流程。

• 要手动创建所需的方法文件，单击 No，然后取消导入。继续以下章节：创建处理方
法。

9. 单击 Yes。

图 6-3 Method Generator 对话框

10. 从 Source data folder 列表选择相应的文件夹。

11. 从 Parameters to copy 列表选择相应的方法文件。

12. 单击 Compound structure folder 字段右侧的文件夹图标，然后浏览到包含处理参数的
母离子结构的文件夹并将其选中。

13. 执行以下任一操作：

• 如果样本 wiff 文件包含参考 MS/MS，则单击 Sample。

• 如果对照品 wiff 文件包含参考 MS/MS，则单击 Control。

14. 单击 Create。
处理参数以及任何缺失的文件夹都将创建并存储在 Excel 电子表格中指定的位置。
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15. 执行以下任一操作：

• 如果选择了 Convert and Open 选项，则继续以下章节：提交批次。

• 如果选择了 Convert 选项，则继续以下章节：保存批次。

保存批次
在批处理工作区中已添加到表格中的信息可以保存下来供以后使用。

1. 要使用相同文件名保存批次，单击 Save。

2. 要使用不同名称创建批次，单击 Save As。
Save Processing Batch As 对话框随即打开。

3. 键入唯一 Name，然后单击 OK。

提交批次
准备了批次并指定了批次选项之后，提交该批次以进行数据处理。

注释: 如果需要，在提交批次之前可以修改感兴趣样本的处理参数。

1. （可选）要查看样本的处理参数，请执行此操作：

a. 选择包含感兴趣样本的行，然后单击位于 Processing Parameters 字段右侧的 P。
与所选样本关联的处理参数随即显示。

b. 进行任何必要的修改，然后单击 Save and Close。
Batch 工作区随即显示。

2. 单击 Save As。
Save Processing Batch As 对话框随即打开。

3. 键入唯一 Name，然后单击 OK。

4. 单击 Find Metabolites。
批次处理开始。进度条显示处理的状态。在处理过程中，P 将被禁用以防止修改这些参
数。当行的处理完成后，位于 Processing Parameters 字段右侧的 P 和位于 Results
File 字段右侧的 R 变成可用状态。

5. 单击 R 以在 Results 工作区中打开结果文件。

注释: 在 Batch Processing Options 对话框中选择的任何 Auto Assign 和 Report 选项都由
软件完成。

6. （可选）完成第 1 步以保存更新过的处理参数。

7. 单击 Save。

提示! 单击 Save As 使用不同的名称保存批次。

搜索可能分子
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查看结果 7
使用 Results 工作区查看在感兴趣样本中搜索可能代谢物所获得的结果。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

关于 Results 工作区
在软件处理了数据之后，使用 Results 工作区查看可能代谢物列表。

图 7-1 Results 工作区

查看结果
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项目 描述

1 菜单栏。包含以下按钮：
• View

• Processing Parameters：显示结果的处理参数。

• Batch Options：显示结果的批次处理选项。

• Sample Details：显示关于样本的详细信息。

• Open：打开 Open Results 对话框，用户可从中浏览到相应的结果文
件。

• Save：保存当前打开的结果文件。自动替换现有版本。

• Save As：保存当前打开的结果文件。用户可以选择目标文件夹并为结
果文件指定新名称。

2 Potential Metabolites 窗格。列出所选算法在感兴趣样本中找到的所有
峰。请参阅以下章节：关于找峰策略。

通过删除不包含可能代谢物的行，更改名称和化学式，添加 MS/MS 谱
图，以及指定峰 ID 来对结果进行编辑。请参阅以下章节：编辑结果。

关于 Potential Metabolites 表中的列的描述，请参阅以下章节：表 7-1。

注释: 预定义筛选器可能会影响列表中显示的可能代谢物。请参阅表格：
关于结果筛选器。

3 Details 窗格。提供关于可能代谢物的评分方式的信息。对于处理方法中的
每个属性，Scoring 列表显示每种代谢物的评分以及所有代谢物的总评
分。请参阅以下章节：Confirmation Scoring 选项卡。显示 Mass Defect
（对寡核苷酸禁用）、Isotope Pattern、MS/MS、Mass Accuracy 和
Total confirmation score 的评分。

对于小分子结果，Structure 列表显示可用的结构。

对于 ADC 结果，Structure 列表同时显示可用的结构和可用的序列。

对于肽结果，Sequence 列表显示可用的序列。

对于寡核苷酸结果，Sequence 列表显示所选代谢物的寡核苷酸序列，它
由在 Interpretation 视图中指定的 MS/MS 确定。如果未指定，则此字段留
空。
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项目 描述

4 Chromatograms 窗格。让用户能够显示所找到的可能代谢物的不同色谱
图：

• Metabolites：显示当前找到的所有代谢物峰的总和。显示所有主要的
色谱峰，及其 RT 和峰 ID。所选代谢物峰以及在相同保留时间洗脱的
任何峰都为黄色。

• XIC：显示所选代谢物的提取离子色谱图 (XIC)。在图形顶部标记出为
XIC 提取选择的同位素。

• Mass Defect：显示用于识别所选代谢物的质量亏损色谱图。这仅适用
于小分子数据。

• Isotope Pattern：显示同位素模式与母体化合物匹配的所有峰的色谱
图。

• Product Ions：显示碎片离子与 Product Ion and Neutral Losses 选项
卡上选定碎片匹配的所有峰的色谱图。

• Neutral Losses：显示中性丢失与 Product Ion and Neutral Losses 选
项卡上选定中性丢失匹配的所有峰的色谱图。

• Isotope Pattern（SWATH 采集数据）：显示碎片同位素模式与
Product Ion and Neutral Losses 选项卡上选定碎片同位素模式匹配的
所有峰的色谱图。

• Analog Data：显示所有峰的模拟色谱图。峰标签指示模拟峰和相应
MS 峰的匹配峰 ID。

注释: 对于 Mass Defect、Isotope Pattern、Product Ions、Neutral
Losses 和 Isotope Pattern（SWATH 采集数据），只有选择这些算法进
行处理时，色谱图才可用。此外，如果按照处理方法中的规定处理了模拟
数据，则 Analog Data 色谱图在 Chromatograms 列表中可用。

注释: 在寡核苷酸工作流程中，只有 Metabolites、XIC 和 Analog Data
视图可用。

注释: 如果选中 Show Controls 复选框，则 XIC 和 Analog Data 色谱图
（如适用）都会显示对照迹线。
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项目 描述

5 MS 窗格。显示 MS 谱图。Show 列表中的选项可选择要突出显示的峰：

• Default：显示样本 MS 的一部分，以所选代谢物的 m/z 值为中心。

• Mass Defect：突出显示与处理方法中选择的任何质量亏损过滤匹配的
所有 m/z 值。这仅适用于小分子数据。

• Isotope Pattern：突出显示同位素模式与母体化合物相同的所有 m/z
值。

对于寡核苷酸工作流程，默认情况下 Predicted Isotope Pattern 和
Charge Series 迹线会进行叠加。默认视图显示所选代谢物的棒状 TOF
MS 谱图。单同位素峰标记出预测电荷，通过蓝色箭头指示其位置。m/z
轴上的红色箭头指示为 XIC 提取和面积确定选择的每个同位素。理论同位
素包络与棒状图峰叠加，以对观察到的数据进行拟合优度评估。要将谱图
设置为全范围，双击 m/z 轴下方。要查看所选代谢物的其他电荷状态的预
测位置，单击左键并在 m/z 轴上拖动以进行平移和缩放。

6 MS/MS 窗格。显示所选代谢物的 MS/MS 谱图。此数据的来源是下述文
件之一：

• 样本 IDA wiff 文件。

• 样本 SWATH 采集 wiff 文件。

• 添加到结果文件的专用 MS/MS wiff 文件。请参阅以下章节：使用 Add
MS/MS 按钮添加多个谱图。

对于寡核苷酸，与在处理参数中选择的参考 MS/MS 谱图匹配的共同子离
子峰为黄色。不匹配的子离子峰为蓝色。

表 7-1 Potential Metabolites 表中的列

列 描述

Report 选择后，在最终报告中包括代谢物。

Peak ID 显示代谢物的峰 ID。该 ID 基于代谢物的保留时间和质量。对于所有母体
代谢物，Peak ID 留空。

-# 分配给质量和保留时间相同但电荷不同的峰。例如，M1-1、M1-2、
M1-3，依此类推。

Name 显示代谢物的名称。

对于 ADC 结果，名称前有 Parent 一词。Parent 表示小分子药物（有效

载荷）和交联剂成分相结合。

对于寡核苷酸结果，主要成分通过 Parent 和 Ion charge 字样指示。

由预测峰发现器确定的生物转化和裂解产物使用典型的 5' 或 3' (n-#) 标记
法。一般峰发现器结果通过 Gain 或 Loss 前缀指示。
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表 7-1 Potential Metabolites 表中的列 (续)

列 描述

Formula 显示代谢物的中性化学式。

Assigned 选择后，指示 Interpretation 工作区中存在该信息。例如，可能显示结构
或序列，也可能填充 Fragments 表。

Neutral Mass 显示代谢物的中性质量。

m/z 显示代谢物的单同位素质荷比。

对于寡核苷酸结果，如果未观察到单同位素，则软件计算其位置并通过
(n) 标示 m/z 值，其中 n 指示单同位素与观察到的第一个峰相差的峰数
量。

Charge 显示代谢物的电荷。

Peak Index 反映为代谢物显示的 XIC 峰面积的同位素。

• Blank cell：单同位素

• 1：单同位素峰之后的第一个同位素

• 2：单同位素峰之后的第二个同位素，依此类推

如果表中未包含该列，则 XIC 峰面积与代谢物的单同位素关联。对于通过
预测代谢物找峰策略识别的代谢物，显示代谢物的估计假定基峰指标。对
于通过其他找峰策略识别的代谢物，显示实验同位素峰。通常，实验同位
素峰是基峰。但是，对于 IDA 数据，实验同位素峰可能是母离子的指标。

ppm 显示代谢物的质量准确度（单位为 ppm）。

R.T. (min) 显示代谢物的保留时间。

Peak Area 显示其峰指标在 Peak Index 列中显示的同位素的 XIC 峰面积。

% Area 根据表中的代谢物总数，显示 XIC 的面积百分比。

% Score 显示代谢物的百分比评分。

Analog - Peak
Area

显示模拟峰的峰面积。仅在处理了模拟数据时可用。

Analog - %
Area

显示模拟峰的面积百分比。仅在处理了模拟数据时可用。

Analog - R.T.
(min)

显示模拟峰的保留时间。仅在处理了模拟数据时可用。

仅显示筛选后的谱图

注释: 此功能不适用于寡核苷酸工作流程。

查看结果

软件用户指南
RUO-IDV-05-12707-ZH-A

Molecule Profiler 软件
61/127



如果选择了 Use advanced MS/MS filter 参数以在 Processing Parameters 工作区 Generic
Parameters 组的 MS/MS Parameters 选项卡中处理 SWATH 采集数据文件，则选中此复选框
可仅显示使用高级筛选器筛选后的 MS/MS 谱图。清空此复选框可显示背景减除谱图。

注释: 如果选择了 Use advanced MS/MS filter 参数，但是在 MS/MS 谱图中仅显示背景减除
谱图，则原因可能是：

• 谱图使用的是空筛选器。

• 强度大约为 10 倍或更高的共洗脱峰产生的干扰导致高级筛选器无效。

• 母离子峰上的数据点少于五个而导致高级筛选器无效。

关于结果筛选器
可以应用筛选器以细化 Potential Metabolites 表中显示的结果。

提示! 单击筛选器图标  打开 Results Filters 对话框。

表 7-2 筛选器

选择此筛选器 显示以下内容

Metabolites

Top __ metabolites by
peak area

仅峰面积百分比排在前面的指定若干位的峰。

Reported metabolites 仅在 Report 列中选择的代谢物。

Metabolites by adduct 仅按主要加合物找到的代谢物。主要加合物定义为充当 Generic
Parameters > MS Parameters 选项卡的 Advanced Ion Types
表中的第一个可见选项的加合物。选项包括：

• Primary

• Most intense

Assigned Metabolites

Metabolites with
structures or
sequences assigned

仅拥有指定结构（小分子）或指定序列（肽和寡核苷酸）的代谢
物，通过 Potential Metabolites 表的 Assigned 列中的选取标记
指示。

Retention Time Window

Retention time from __
to __

仅处在指定范围内的峰。

Peak Area

Peak area from __ % to
__ %

仅面积百分比在指定百分比范围内的峰。
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表 7-2 筛选器 (续)

选择此筛选器 显示以下内容

Analog peak area from
__ % to __ %

仅模拟面积在指定百分比范围内的峰。如果未提供模拟文件以供
处理，则此筛选器无效。

Charge

Charge from __ to __ 仅电荷值在指定范围内的代谢物。

Score

Overall score above __
%

仅总评分高于指定值的峰。请参阅以下章节：Confirmation
Scoring 选项卡。

对于寡核苷酸工作流程，我们建议使用同位素包络作为确认评分
的唯一参数。我们还建议用户将 Overall Score 设置为高于
20%，以除去理论同位素重叠评分较低的代谢物。

Mass Accuracy

Accuracy within __
ppm

仅质量准确度在指定范围内的峰。

Mass Range

m/z from __ to __ 仅处在指定范围内的 m/z 值。

Product Ions and Neutral Losses

MS/MS similarity above
__

仅 MS/MS 相似性评分高于指定值的峰。如果未提供参考谱图，
则此筛选器无效。

Minimum number of
common product ions
__

仅至少拥有指定数量与母体化合物相同的子离子的峰。如果未提
供参考谱图，则此筛选器无效。

Minimum number of
common neutral losses
__

仅至少拥有指定数量与母体化合物相同的中性丢失的峰。如果未
提供参考谱图，则此筛选器无效。

注释: 在表格中删除和添加行将会自动更新每种代谢物的 % Area 和 % Analog Area，影响将
峰面积、模拟峰面积和按峰面积排序靠前的代谢物筛选器应用于剩余行的方式。

编辑结果
可以编辑或删除 Potential Metabolites 表以进一步细化结果。

用户可以：

• 删除行

• 编辑可能代谢物的名称和化学式

• 指定峰 ID
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删除行

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 选择 Potential Metabolites 表中的行。

提示! 单击并按下 Ctrl 或 Shift 以选择多个行。

6. 单击 Edit > Delete Selected Rows.

提示! 要恢复最近的删除操作，单击 Edit > Undo Delete。

7. 单击 Save。

编辑可能代谢物的名称和化学式

请参阅以下章节：软件如何命名代谢物。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 右键单击 Potential Metabolites 表中的行，并选择 Edit Name and Formula。
Edit Name and Formula 对话框随即打开。

6. 请执行以下任一操作以更改 Name：

• 如果适用，从提供的选项列表中选择相应的名称。

• 键入新名称。

7. 如果适用，从提供的选项列表中选择相应的加合物。

注释: 如果更改加合物，则代谢物的 Mass accuracy 自动更新。

8. 请执行以下任一操作以更改 Formula：

• 如果可用的信息不足以确定化学式，则选择 Unknown。

• 要手动为可能代谢物添加化学式，选择 Use，然后在提供的字段中键入化学式。

• 如果软件预测了可能化学式，则选择 Automatic，并从列表中选择相应的条目。
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注释: 如果软件未预测可能化学式，则无法选择 Automatic。

注释: 当添加新化学式时，软件自动更新 Mass accuracy 和 RDB 字段中的值。

9. 要从所的选行中识别作为母体化合物的代谢物，单击 Assign as Parent。

10. 单击 OK。

11. 单击 Save。

注释: 对于肽，名称顺序基于提议名称的质量准确度以及所需的操作次数，例如断裂的键
数量。即，质量准确度较高、操作次数较少的肽的提议名称显示在列表顶部。

按峰分组

使用 Group by Peaks 按钮将中性质量相同的峰（例如，分子的多种电荷状态）归为一组，以
显示所识别分子的汇总表以及 Peak Area、%Area 等，这些信息针对所有识别的电荷状态进
行加总。峰根据中性质量和保留时间公差进行分组。

注释: 分组功能仅适用于寡核苷酸工作流程。

指定峰 ID
1. 在 Workspace 面板中，单击 Results。

Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 审核 Potential Metabolites 表中的当前峰 ID。

6. 对该表进行任何更改，包括删除行和重命名代谢物。

7. 单击 Assign ID。

与相同中性化学式和保留时间相关的行归为一组。为一行指定主要峰 ID，为该组中其余的
行指定连续 ID，比主要峰 ID 低一级。例如，如果指定的主要峰 ID 为 M2，则为其余的每
个行指定以 M2 开头的连续 ID。例如，M2-1、M2-2，依此类推。

非主要峰 ID 指定给包含非主要加合物的峰。非主要加合物是指已在 Advanced Ion Types
表中选择但未显示在 Ion type 列表中的加合物。只有主要峰 ID 显示在 Ion type 列表中。

MS/MS 谱图

对于任何代谢物，可以添加、删除或替换 MS/MS 谱图。MS/MS 谱图可以通过在 Explorer 工
作区中复制棒状图 MS/MS 谱图，然后在 Results 工作区中粘贴来手动添加，也可以通过
Results 工作区中的 Add MS/MS 按钮自动添加。
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通过粘贴添加谱图

注释: 这是测试版功能。

注释: 此功能仅在寡核苷酸工作流程中可用，适合 TOF-MS/MS 和 IDA 数据。目前不支持从
IDA Explorer 粘贴 MS/MS 谱图。数据文件必须先以标准 TIC 和棒状图格式在 Explorer 工作区
中打开，然后才能粘贴到 Molecule Profiler 中。

注释: 结果文件保存完毕后，才会覆盖结果文件中的现有 MS/MS 谱图。要恢复为所选代谢物
存储在结果文件中的原始谱图，请在保存结果文件之前单击 Remove MS/MS。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到并选择相应的文件，然后单击 OK。
Results 视图随即显示出来。

4. 选择 Potential Metabolites 表中的行。

5. 从 SCIEX OS 主页中，打开 Explorer 工作区。

6. 选择 File > Open Sample。
Select Sample 对话框随即打开。

7. 浏览到包含样本的数据文件，单击 + 将其展开，选择要打开的样本，然后单击 OK。

该数据文件必须是包含 TOF-MS/MS 或 IDA 数据的 wiff 或 wiff2 数据文件。

8. 如果数据文件包含 IDA 数据，在 Open IDA Sample 对话框中选择 As a standard TIC，
然后单击 OK。

9. 打开 MS 和 MS/MS 谱图。

提示! 要打开谱图，设置选择窗口，或在 TIC 窗格中双击保留时间。

10. 右键单击 MS/MS 谱图的标题，然后选择 Remove All Traces Except Active。

11. 选择 Process > Centroid Spectrum。
Centroid 对话框随即打开。

12. 选择是否将 Intensity、Height、Area 或 Intensity sum above 50% 处理成棒状图。

13. 选择 Edit > Copy。

14. 转到 Molecule Profiler 工作区。

15. 单击 Paste MS/MS。
MS/MS 谱图已添加。

16. 单击 Save。
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使用 Add MS/MS 按钮添加多个谱图

注释: 结果文件保存完毕后，才会覆盖结果文件中的现有 MS/MS 谱图。要恢复为所选代谢物
存储在结果文件中的原始谱图，请在保存结果文件之前单击 Remove MS/MS。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件并选择该文件，然后单击 OK。
Results 视图随即显示出来。

4. 选择 Potential Metabolites 表中的行。

5. 单击 Add MS/MS。
Add MS/MS 对话框随即打开。

6. 单击 Select MS/MS。
Select Data 对话框随即打开。

7. 浏览到相应的 Source 文件夹并选择该文件夹。

8. 单击 OK。

9. 在 Select Data 对话框的 Available 窗格中，选择包含 MS/MS 谱图的 wiff 文件和进样，然

后单击图标 ( ) 将文件移动到 Selected 窗格。

提示! 最多可以选择 10 个进样。

10. 当所有必需文件都显示在 Add MS/MS 对话框中时，单击 OK。
软件尝试为每个代谢物找到匹配谱图。

11. 审核每个代谢物的评分。
如果更改了 MS/MS 谱图，则软件可能会重新计算 % Score。

12. 单击 Save。
要编辑单个 MS/MS 谱图内的特定碎片类型，请参阅以下章节：寡核苷酸工作流程。

删除谱图

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 选择 Potential Metabolites 表中的行。

6. 在 MS/MS 窗格中，单击 Remove MS/MS。

查看结果
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注释: 如果可能代谢物存在 IDA 谱图，则它显示在 MS/MS 窗格中。

7. 单击 Save。

删除 MS/MS 谱图文件

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 单击 Add MS/MS。

6. 在 MS/MS Samples 字段中选择相应的 wiff 文件。

7. 单击 Remove，然后单击 OK。
wiff 文件中的所有专用 MS/MS 谱图都将从结果中删除。

8. 单击 Save。
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表征 MS/MS 数据 8
识别感兴趣样本的峰之后，利用碎片解读来帮助识别每种可能代谢物的结构。

关于解读视图
Results 工作区中的 Interpretation 视图显示了帮助阐明结果文件中每种代谢物的潜在结构所需
的数据和工具。

解读视图

小分子解读视图 肽解读视图 寡核苷酸解读视图 ADC 解读视图

小分子解读视图

图 8-1 小分子解读视图

项目 界面组件 描述

1 MS/MS 窗格 显示所选代谢物的 MS/MS 谱图。如果可用，还会显示
参考 MS/MS 谱图的镜像。星号可识别为指定操作选择
的峰。此谱图的来源是样本 IDA wiff 文件、样本
SWATH 采集 wiff 文件或添加到结果文件的专用
MS/MS wiff 文件。关于按钮所提供功能的描述，请参
阅表格：表 8-1。
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项目 界面组件 描述

2 Fragments 表 列出所选代谢物的所有指定碎片，包括其 m/z 值、提
议结构数量和评分。如果特定 m/z 值可以得到不同的
化学式，则表格中每个化学式对于一行。默认情况下，
化学式和 m/z 值的各种组合评分最高的行已选中 Use
复选框。

提示! 未选中 Use 复选框的行可能会隐藏起来。要显示
所有行，右键单击该表，然后单击 Show Hidden
Rows。

关于图标所提供功能的描述，请参阅表格：表 8-3。

2a Structure Details
表

列出结构中可产生所选碎片的部分，包括断裂的键数
量、H 值之差和分数。选择此表中的行可突出显示结构
中的相关部分。

默认情况下，评分最高的碎片结构已选中 Use 复选
框。

2b Contained
Neutral Losses
表

包含两个碎片质量的中性丢失。

3 Structure charts
窗格

包含下面两个选项卡：

• Parent Structure 选项卡，它包含所选代谢物的母结
构。

• Structure Candidates 选项卡是一种交互式直方图，
它包含的表格显示提议结构的完整列表，按照评分
的降序排列。选择此表中的行可更改 Structure 窗格
中显示的结构（项目 2）。要将特定结构包含在结
果中，单击该结构的 Apply to Results 复选框。请
参阅以下章节：关于 Structure Candidates 选项
卡。

4 Structure 窗格 让用户能够加载可能代谢物的候选结构，并提供基本绘
图工具以使用户能够编辑该结构。关于按钮所提供功能
的描述，请参阅表格：表 8-2。

表 8-1 MS/MS 窗格按钮

按钮 描述

Deisotope 在 MS/MS 窗格中隐藏所有同位素。再次单击可显示同位素。

Prepare 打开 Interpret Data 对话框，用户可在此编辑解读所选代谢物需要的
详细信息（化学式、活动峰、MS/MS 谱图重新校准）。
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表 8-1 MS/MS 窗格按钮 (续)

按钮 描述

Options 打开 Options 对话框，用户可在此指定 MS/MS 碎片。请参阅设置选
项章节中的表格：表 8-15。

Generate 使用为所选代谢物自动生成的可能候选项填充 Structure Candidate
选项卡。请参阅以下章节：关于 Structure Candidates 选项卡。

Apply 将解读变化应用于所选峰。

Remove 从所选峰删除指定的碎片和代谢物结构。

表 8-2 Structure 窗格按钮

按钮 描述

Load • 加载母体：打开所选代谢物的母结构。

• 加载结构：打开所选峰的结构文件。

Delete 从 Structure 窗格中删除可见结构。

Save As 让用户能够使用不同的文件名保存可见结构。

Assign 计算可能结构的碎片和中性丢失，然后将离子指定给 MS/MS 谱图。

表 8-3 Fragments 表图标

图标 描述

为所选碎片添加标签。

从 MS/MS 谱图删除所有标签。

打开 Interpretation Filters 对话框。请参阅以下章节：关于小分子的
解读筛选器。
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肽解读视图

图 8-2 肽解读视图

项目 界面组件 描述

1 MS/MS 窗格 显示所选代谢物的 MS/MS 谱图。如果可用，还会显示
参考 MS/MS 谱图的镜像。此谱图的来源是样本 IDA
wiff 文件、样本 SWATH 采集 wiff 文件或添加到结果文
件的专用 MS/MS wiff 文件。关于按钮所提供功能的描
述，请参阅表格：表 8-4。

2 Sequence 窗格 让用户能够输入序列。关于按钮所提供功能的描述，请
参阅表格：表 8-5。

3 Fragments 表 包含所选可能代谢物的提议化学式列表。列表中包括
m/z 值、序列、碎片离子类型（例如，y 或 b）、电
荷、误差和强度。关于图标所提供功能的描述，请参阅
表格：表 8-6。

4 Sequence charts
窗格

包含下面两个选项卡：

• Parent Sequence 选项卡，它包含母体药物的序
列。

• Sequence Candidates 选项卡，它是一种交互式直
方图，所包含的表格显示软件正在提议的序列的列
表。根据指定的峰面积百分比，对每个提议序列进
行评分。要将特定序列应用于结果，选中该序列的
Apply to Results 复选框。结果文件关闭然后再次
打开之后，应用的序列显示为默认序列。请参阅以
下章节：关于 Sequence Candidates 选项卡。
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表 8-4 MS/MS 窗格按钮

按钮 描述

Deisotope 从 MS/MS 谱图删除所有同位素。

Options 打开 Options 对话框。请参阅设置选项章节中的表格：表 8-16。

Generate 使用为所选代谢物自动生成的可能候选项填充 Structure Candidate
选项卡。请参阅以下章节：关于 Structure Candidates 选项卡。

Apply 将解读变化应用于所选峰。

Remove 从所选峰删除指定的碎片和代谢物结构。

表 8-5 Sequence 窗格按钮

按钮 描述

Enter Sequence 让用户能够在 Sequence 窗格中键入新序列。请参阅以下章节：肽序
列命名惯例。

Load Parent 打开所选代谢物的母序列。

Delete 从 Sequence 窗格中删除可见序列。

Assign 计算可能结构的碎片和中性丢失，然后将离子指定给 MS/MS 谱图。

表 8-6 Fragments 表图标

图标 描述

为所有峰添加标签。

为所选碎片添加标签。

从 MS/MS 谱图删除所有标签。

打开 Interpretation Filters 对话框。请参阅以下章节：关于肽的解读
筛选器。
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寡核苷酸解读视图

图 8-3 寡核苷酸解读视图

项目 界面组件 描述

1 MS/MS 窗格 显示所选代谢物的 MS/MS 谱图。如果可用，还会显示
参考 MS/MS 谱图的镜像。此谱图的来源是样本 IDA
wiff 文件、样本 SWATH 采集 wiff 文件或添加到结果文
件的专用 MS/MS wiff 文件。关于按钮所提供功能的描
述，请参阅表格：表 8-7。

2 Fragments 表 包含所选可能代谢物的提议化学式列表。列表中包括
m/z 值、序列、碎片离子类型（例如，y 或 b）、电
荷、误差和强度。关于图标所提供功能的描述，请参阅
表格：表 8-6。

3 Sequence charts
窗格

包含母体药物的序列。

4 Sequence 窗格 让用户能够输入序列。关于按钮所提供功能的描述，请
参阅表格：表 8-5。

表 8-7 MS/MS 窗格按钮

按钮 描述

Deisotope 从 MS/MS 谱图删除所有同位素。

Options 打开 Options 对话框。请参阅设置选项章节中的表格：表 8-18。

Apply 将解读变化应用于所选峰。

Remove 从所选峰删除指定的碎片和代谢物结构。
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表 8-8 Sequence 窗格按钮

按钮 描述

Load Parent 打开所选代谢物的母序列。

Delete 从 Sequence 窗格中删除可见序列。

Assign 计算可能结构的碎片和中性丢失，然后将离子指定给 MS/MS 谱图。

表 8-9 Fragments 表图标

图标 描述

为所有峰添加标签。

为所选碎片添加标签。

从 MS/MS 谱图删除所有标签。

打开 Interpretation Filters 对话框。请参阅以下章节：关于寡核苷酸
的解读筛选器。

ADC 解读视图

图 8-4 ADC 解读视图
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项目 界面组件 描述

1 MS/MS 窗格 显示所选代谢物的 MS/MS 谱图。如果可用，还会显示
参考 MS/MS 谱图的镜像。此谱图的来源是样本 IDA
wiff 文件、样本 SWATH 采集 wiff 文件或添加到结果文
件的专用 MS/MS wiff 文件。关于按钮所提供功能的描
述，请参阅表格：表 8-10。

2 Fragments 表 包含下列选项卡：

• Structure 选项卡，它列出所选代谢物的所有指定碎
片，包括其 m/z 值、提议结构数量和评分。如果可
以为特定 m/z 值指定不同的化学式，则表中每个公
式对应一行。默认情况下，化学式和 m/z 值的各种
组合评分最高的行已选中 Use 复选框。

• Sequence 选项卡列出了所选可能代谢物的所有提议
化学式。列表中包括 m/z 值、序列、碎片离子类型
（例如，y 或 b）、电荷、误差和强度。

关于图标所提供功能的描述，请参阅表格：表 8-13。

3 Sequence 窗格 显示序列中与有效载荷或交联剂基团共轭的部分。要指
示与有效载荷或交联剂基团共轭的残基，请选择该残
基，右键单击，然后选择 Mark Residue to
Conjugate。

4 Structure 窗格 让用户能够上传可能代谢物的候选结构，并提供基本绘
图工具以供用户编辑该结构。关于按钮所提供功能的描
述，请参阅表格：表 8-11。

表 8-10 MS/MS 窗格按钮

按钮 描述

Deisotope 从 MS/MS 谱图删除所有同位素。

Options 打开 Options 对话框。请参阅设置选项章节中的表格：表 8-21。

Apply 将解读变化应用于所选峰。

Remove 从所选峰删除指定的碎片和代谢物结构。

表 8-11 Structure 窗格按钮

按钮 描述

Load • Load Parent Structure：打开所选代谢物的母结构。

• Load Sequence：打开所选代谢物的序列。
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表 8-11 Structure 窗格按钮 (续)

按钮 描述

Delete 从 Structure 窗格删除加载的结构，从 Sequence 窗格删除加载的序
列信息，并从 Fragments 表中删除指定的结构和序列信息。

Save Structure As 让用户能够使用不同的文件名保存结构。

Assign 计算可能结构的碎片和中性丢失，然后将离子指定给 MS/MS 谱图。

表 8-12 Fragments 表按钮

按钮 描述

Structure 列出所选代谢物的所有指定碎片，包括其 m/z 值、提议结构数量和评
分。如果可以为特定 m/z 值指定不同的化学式，则表中每个公式对应
一行。默认情况下，化学式和 m/z 值的各种组合评分最高的行已选中
Use 复选框。

Sequence 列出所选可能代谢物的所有提议化学式。列表中包括 m/z 值、序列、
碎片离子类型（例如，y 或 b）、电荷、误差和强度。

表 8-13 Fragments 表图标

图标 描述

为所有峰添加标签。

为所选碎片添加标签。

从 MS/MS 谱图删除所有标签。

打开 Interpretation Filters 对话框。请参阅以下章节：关于 ADC 的解
读筛选器。

手动解读

手动解读

小分子工作流程 肽工作流程 寡核苷酸工作流程 ADC 工作流程

小分子工作流程

加载结构

编辑结构

准备结构指定 编辑可能代谢物的名称和化学式
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重新校准 MS/MS 谱图

MS/MS 谱图去同位素

选择活动峰

选择碎片峰进行指定

设置选项

指定碎片结构 指定建议的化学式和结构

为每个碎片选择化学式结构

附加 Markush 结构

关于峰标签 向 MS/MS 谱图添加峰标签

关于小分子的解读筛选器

加载结构

在开始代谢物结构测定之前，加载使软件能够确定可能碎片结构的结构文件。

注释: 如果未加载结构，仍可向碎片指定可能的化学式。

1. 在 Workspace 面板中，单击 Results。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览并选择结果文件。

4. 单击 OK。

5. 在 Show 字段中，选择 Interpretation。

6. 选择 Potential Metabolites 表中的行。

7. 在 Structure 窗格中，单击 Load，然后选择 Load Structure 选项。
Open Structure File 对话框随即打开。

8. 浏览并选择结构文件。

注释: 软件可接受 sdf 或 mol 格式的结构文件。

9. 如果需要进行细微更改，则编辑该结构。请参阅以下章节：编辑结构。

编辑结构

加载特定代谢物的结构之后，使用编辑工具进行细微的更改。

提示! 使用编辑工具对结构进行细微的更改，例如代谢转化的不同附着位置。编辑工具不应当
用来创建新结构或对现有结构进行重大更改。
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表 8-14 编辑结构

目的 方法

向结构添加原子 在调色板上将特定符号拖动到新位置。添加的原子与距
离最近的现有原子形成单键。

在调色板上创建新原子 单击空白方块，在 Specify Symbol 对话框中键入符
号，然后单击 OK。

提示! 单击添加的方块，键入新符号以创建不同的原
子。

突出显示结构中的一个部分 在所需的原子和键周围拖动出一个圆圈。

移动一个或多个原子 将结构中突出显示的部分拖动到新位置。如果该部分通
过键与另一个原子结合，则该键移动到新位置。如果该
部分通过键与两个或多个原子结合，则该部分移动，但
现有的键保持不变。

将结构插入到现有结构中 右键单击结构，并单击下面的选项之一：

• Insert .mol File，用于添加另一个结构。

• Insert Conjugate，用于添加特定共轭结构。

删除一个或多个原子 右键单击结构中突出显示的部分，然后单击 Remove
Selected Atoms。

创建键 选择两个未通过键相连的原子，右键单击所选的项，单
击 New Bond，然后选择键类型。

编辑键 右键单击键，单击 Set Bond Type，然后选择键类
型。

删除键 右键单击键，然后单击 Remove Bond。

更改现有原子的电荷状态 右键单击原子，单击 Atom Charge State，然后选择
状态。

提示! 要将编辑后的结构保存为单独的文件，单击 Save As。

提示! 结构可以保存为 mol 或 sdf 文件。在 Save As 对话框中键入相应的扩展名。

准备结构指定

用户在准备结构指定时，可以完成四个任务：

• 编辑可能代谢物的名称或化学式。

• 重新校准 MS/MS 谱图。

• 选择 MS/MS 谱图中的特定峰。
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• 选择碎片峰进行解读。

注释: 如果不需要完成这些任务，则用户可以忽略这些程序，并立即指定碎片结构。

编辑可能代谢物的名称和化学式

请参阅以下章节：软件如何命名代谢物。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 右键单击 Potential Metabolites 表中的行，并选择 Edit Name and Formula。
Edit Name and Formula 对话框随即打开。

6. 请执行以下任一操作以更改 Name：

• 如果适用，从提供的选项列表中选择相应的名称。

• 键入新名称。

7. 如果适用，从提供的选项列表中选择相应的加合物。

注释: 如果更改加合物，则代谢物的 Mass accuracy 自动更新。

8. 请执行以下任一操作以更改 Formula：

• 如果可用的信息不足以确定化学式，则选择 Unknown。

• 要手动为可能代谢物添加化学式，选择 Use，然后在提供的字段中键入化学式。

• 如果软件预测了可能化学式，则选择 Automatic，并从列表中选择相应的条目。

注释: 如果软件未预测可能化学式，则无法选择 Automatic。

注释: 当添加新化学式时，软件自动更新 Mass accuracy 和 RDB 字段中的值。

9. 要从所的选行中识别作为母体化合物的代谢物，单击 Assign as Parent。

10. 单击 OK。

11. 单击 Save。

注释: 对于肽，名称顺序基于提议名称的质量准确度以及所需的操作次数，例如断裂的键
数量。即，质量准确度较高、操作次数较少的肽的提议名称显示在列表顶部。

重新校准 MS/MS 谱图

1. 在 Interpretation 视图中，单击 Prepare。
Interpret Data 对话框随即打开。
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2. 单击 MS/MS Details 选项卡。

3. 选择用作校准点的碎片。

4. 右键单击所选碎片，然后单击 Set calibration points。
碎片圆环的颜色变成蓝色。

5. 重复第 3 步和第 4 步以选择其他校准点。

6. 要删除设置的校准点，选择相应的校准点，单击右键，然后选择 Clear calibration
points。
碎片圆环的颜色恢复绿色。

7. 要查看碎片的详细信息，选择一个校准点，单击右键，然后选择 Composition details。
Fragment 对话框随即打开，提供 m/z 值、使用 ppm 和 mDa 两种单位的质量误差、指示
推荐的化学式是否指向偶电子，以及推荐化学式的 RDB 值（环键和双键）。

8. 要选择校准点作为碎片组成或作为可能校准点，选择一个校准点，单击右键，然后选择
Select composition。

9. 右键单击 MS/MS 谱图，然后单击 Recalibrate。

注释: 要放弃已重新校准的谱图，右键单击该谱图，然后单击 Revert Calibration。

MS/MS 谱图去同位素

在 Interpretation 视图中，单击 Deisotope 时，将会从 MS/MS 谱图中去除所有同位素。这样
可快速查看单同位素峰，对于查看 SWATH 采集数据非常有用。

注释: 无论是否选择此选项，在 Results Table 中都只显示单同位素。

选择活动峰

活动峰是 MS/MS 谱图中唯一可用于碎片解读的峰。

1. 在 Interpretation 视图中，单击 Prepare。
Interpret Data 对话框随即打开。

2. 审核 MS/MS 谱图。
蓝色箭头可识别当前的活动峰。

3. 要选择峰，在峰上拖动出方块。

4. 双击所选的峰。
所选的峰下方显示一个蓝色箭头。

5. 要删除单个峰，将蓝色箭头拖动到 Interpret Data 对话框的边框下。
蓝色箭头将从所选的峰下方删除。

提示! 要清除所有活动峰，右键单击谱图，然后单击 Clear All Markers。

6. 选择了所有活动峰之后，单击 Find。

7. 选择化学式最适合 MS 和 MS/MS 谱图的行。

8. 单击 Select。
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选择碎片峰进行指定

虽然可能会将多个峰识别为活动，但是用户可以选择仅使用强度最高的峰。

1. 在 Interpretation 视图中，单击 Options。
Options 对话框随即打开。

2. 在 Number of fragment peaks selected for assignment 字段中，键入相应的数字。

3. 单击 OK。
MS/MS 谱图中的星号可识别为指定操作选择的峰。

设置选项

1. 在 Interpretation 视图中，单击 Options。
Options 对话框随即打开。

2. 按下表中所述的方式修改碎裂和标记参数：表 8-15。

表 8-15 Options 对话框

选项 描述

Number of fragment
peaks selected for
assignment

使用此字段指定将指定的碎片峰的数量。此数字可以是在 Prepare
对话框中选择的峰总数的子集。如果它是峰总数的子集，则按强度
的顺序选择峰。

Minimum signal-to-
noise ratio

使用此字段指定用来指定碎片峰的阈值。不会指定低于此阈值的
峰。噪声定义为 MS/MS 谱图中强度最小的峰。

MS/MS m/z
tolerance (ppm or
mDa)

对于要指定化学式且还可能指定结构的碎片峰，其质量准确度必须
处在指定的 MS/MS m/z 公差范围内。

Fragmentation Settings

Break aromatic
rings

选中此复选框以断裂芳香环。

Maximum number
of bonds to break

使用此字段指定要断裂的键最大数量。选项包括：

• 1

• 2

• 3

• 4
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表 8-15 Options 对话框 (续)

选项 描述

Maximum number
of C-C bonds to
break

使用此字段指定要断裂的 C-C 键最大数量。选项包括：

• 0

• 1

• 2

• 3

• 4

Label Settings

Label peaks with 使用此字段指定应显示在峰标签中的信息。选项包括：

• Ion

• Ion with ppm Error

• Ion with mDa Error

Apply options to all
potential
metabolites

选中此复选框以对所有未指定的代谢物应用当前选项。

指定碎片结构

为了指定结构，软件将 MS/MS 谱图中的碎片峰关联到候选结构的可能部分。然后，用户可以
选择与每个碎片的 m/z 值最匹配的化学式和结构。进行指定之后，标识已选择峰进行指定操作
的星号替换成选取标记以表示指定已进行，或者替换成 x 以表示无法进行指定。

注释: 碎裂规则内嵌在软件中，不能编辑。

指定建议的化学式和结构

每种代谢物都必须有 MS/MS 谱图才能指定碎片结构。要添加谱图，请参阅以下章节：使用
Add MS/MS 按钮添加多个谱图。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 在 Show 字段中，选择 Interpretation。

6. 加载并编辑候选结构。请参阅以下章节：加载结构和编辑结构。
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7. 如有必要，准备好结构指定。请参阅以下章节：准备结构指定。

8. 在 Interpretation 视图的 Structure 窗格中，单击 Assign。
在 MS/MS 窗格下显示了三个表格：Fragments 表，显示已识别的碎片；Structure Details
表，显示可能的结构；Contained Neutral Losses 表，显示包含的中性丢失。

注释: 如果未加载结构，则软件仅向碎片指定可能的化学式。

为每个碎片选择化学式结构

1. 如果适用，在 Interpretation 视图中，右键单击每个 Fragments、Structure Details 和
Contained Neutral Losses 表，然后单击 Show Hidden Rows。

注释: 在 Fragments 表中，m/z 值评分最高的行已选中 Use 复选框。在 Structure Details
表中，评分最高的行已选中 Use 复选框。在 Contained Neutral Losses 表中，所有行都
已选中 Use 复选框。

2. 在 Fragments 表中，选中 Use 复选框以识别包含每个 m/z 值的最准确化学式的行。

提示! 在 Fragments 表中，选中多个行中的 Use 复选框，为每个碎片选择多个可能化学
式。

3. 在 Structure Details 表中，选中 Use 复选框以识别与所选化学式最准确匹配的结构部
分。

4. 在 Contained Neutral Losses 表中，选中 Use 复选框以识别最准确地反映了包含的中性
丢失的行。

提示! 在 Structure Details 和 Contained Neutral Losses 表中，为特定碎片选中多个行中
的 Use 复选框。

5. 单击 Apply。
这将保存所选代谢物的解读数据。

6. 完成所有更改后，单击 Save。

提示! 要删除特定代谢物的所有解读数据，单击 Remove。

关于 Structure Candidates 选项卡

使用自动结构生成时，Structure charts 窗格中的 Structure Candidates 选项卡将填充满足
Options 对话框中所设置条件的选定代谢物结构列表。请参阅以下章节：批次处理选项。软件
可为下列类型的代谢物生成结构：

• 经过一次或两次裂解的代谢物

• 单一生物转化代谢物

• 经过一次裂解和单一生物转化的代谢物

对于更复杂的代谢作用，用户可以提供或编辑自定义代谢物结构，并评估此类结构提议。

结构列表（称为直方图）包含下述信息列：
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列 描述

Rank 指示结构的位置或排序。

Relative
Evidence

排序或评分基于母结构的 MS/MS 谱图与代谢物的 MS/MS 谱图之间的比
较。然后，比较代谢物碎片与母体碎片以识别偏移和非偏移碎片。在总体
排序策略中还会考虑其他属性，例如碎片强度和提议唯一性。最终排序指
示在特定原子指标出现生物转化或裂解的概率。

用户还可通过此列在结构之间切换。请参阅以下章节：在结构之间切换。

Apply to
Results

选中复选框表示将会为结果文件保存对应的结构。

候选项总数显示在直方图表格上方，位于 Apply to Results 列正上方。

自动生成的结构不能编辑。用户可以加载结构、进行任何必需的修改，然后选中 Apply to
Results 复选框以将结构包含在结果文件中。请参阅以下章节中的第 7 步和第 8 步：加载结构
和编辑结构。

在结构之间切换

单击直方图中蓝色条。
相应的结构将显示在 Structure 窗格中。

选择空窗格

单击直方图中的第一行。
直方图中的第一行包含文字 No structure。Structure 窗格刷新，显示短语 No
structure。
添加结构

注释: 只能向自动生成结构的列表中添加一个结构。如果添加更多结构，则会覆盖前面的用户
添加的结构。

1. 在 Structure 窗格中，单击 Load，然后选择 Load Structure 选项。
Open Structure File 对话框随即打开。

2. 浏览到 mol 或 sdf 文件，然后将其选中。

3. 单击 Open。

所选结构显示在 Structure 窗格中，并在直方图表格中第一个自动生成的结构上面添加一
行。表示已加载结构行的蓝色阴影与包含自动生成结构的行中的蓝色稍有不同。排序设置
为 0。

用户添加的结构可以编辑。当用户切换出 Structure 窗格时，对结构进行的任何更改都将
保留在内存中。

选择要查看的结构

1. 单击直方图中蓝色条。
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相应的结构将显示在 Structure 窗格中。默认情况下，仅为直方图中的第一个结构指定了
Fragments 表。

2. 要为其他结构指定 Fragments 表，单击直方图中的蓝色条，然后单击 Assign。

删除结构

1. 单击直方图中蓝色条。
相应的结构将显示在 Structure 窗格中。

2. 在 Structure 窗格中，单击 Delete。
结构将从 Structure 窗格中删除，所选蓝线将从直方图中删除，Fragments 表将被删除。
直方图中的下一条线对应的结构显示在 Structure 窗格中。

附加 Markush 结构

指定碎片结构之后，使用 Markush 结构显示化学修饰的大致位置。

注释: 碎片结构不能指定给包含 Markush 结构的代谢物。

1. 突出显示结构中的一个部分。

2. 右键单击结构上方或下方，然后单击 Attach Markush。

3. 选择 Single Bond 或 Double Bond。

4. 在 Select Symbol 对话框中，键入所需的符号或化学式。

5. 单击 OK。

显示的 Markush 结构会有一条虚线将它连接到结构的选定部分。

注释: 如果附加了 Markush 结构，可在指定解读数据之后对结构进行更改。如果删除了
Markush 结构，则任何更改都将删除代谢物的所有解读数据。

关于峰标签

峰可以添加以下标签：

• 离子化学式或离子类型（适用于肽）

• 离子化学式或离子类型（适用于肽）以及 ppm 误差

• 离子化学式或离子类型（适用于肽）以及 mDa 误差

向 MS/MS 谱图添加峰标签

1. 在 Interpretation 视图中，单击 Options。
Options 对话框随即打开。

2. 在 Label peaks with 字段中，选择标签类型。

3. 单击 OK。

4. 在 Fragments 表中，选择包含要标记的峰的行。

5. 单击 。
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提示! 要从 MS/MS 谱图删除所有标签，单击 。

关于小分子的解读筛选器

应用筛选器以细化 Fragments 表中显示的数据。要进入 Interpretation Filters 对话框，单击

Fragments 表中的  图标。

筛选器 描述

Rings and Double Bonds

RDB • Integer value (even-electron)：仅显示环键和双键为整数值
的碎片。

• Non-integer value (odd-electron)：仅显示环键和双键为非
整数值的碎片。

Mass Range

m/z from __ to __ 仅显示 m/z 值在指定范围内的碎片。

Mass Accuracy

Accuracy within 仅显示质量准确度在指定范围内的碎片。

注释: 质量准确度使用的测量单位是 mDa 还是 ppm 取决于在
Options 对话框中的选择。

Intensity

Intensity above __ cps 仅显示强度值高于指定值的碎片。

Score

Score above 仅显示评分高于指定值的碎片。

结构

Fragments with
assigned structures

仅显示与结构关联的碎片。

肽工作流程

加载序列

编辑序列

设置选项

指定碎片序列

关于峰标签 向 MS/MS 谱图添加峰标签

关于肽的解读筛选器
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加载序列

1. 在 Workspace 面板中，单击 Results。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览并选择结果文件。

4. 单击 OK。

5. 在 Show 字段中，选择 Interpretation。

6. 选择 Potential Metabolites 表中的行。

7. 执行以下任一操作：

• 如果 Sequence 窗格为空，则单击 Load Parent。

• 如果序列已在 Sequence 窗格中，并且需要添加新序列，则单击 Enter Sequence 清
空窗格，然后单击 Load Parent。

母序列将显示在 Sequence 窗格中。下面的标签会添加到该窗格上方：AA Index: [ ],
Mono. Mass: [ ], m/z: [ ], Composition: [ ]，其中：

• AA Index（氨基酸索引）：氨基酸索引指示序列的第一个和最后一个残基在母序列中
的位置。如果分解代谢产物序列不是母序列的子集，则不显示 AA 索引。

• Mono. Mass：中性成分的单同位素质量。

• m/z：质荷比的值。电荷显示在括号中。

• Composition：序列中不带电荷的元素组成。

8. 如果需要更改，则编辑该序列。请参阅以下章节：编辑序列。

编辑序列

创建或加载特定代谢物的序列之后，可对其进行编辑。

1. 单击需要进行更改的序列。

2. 进行必要的更改。请参阅以下章节：肽序列命名惯例。

设置选项

1. 在 Interpretation 视图中，单击 Options。
Options 对话框随即打开。

2. 修改碎裂和标记参数。请参阅表格：表 8-16。

表 8-16 Options 对话框

选项 描述

Minimum signal-to-
noise ratio

使用此字段指定用来指定碎片峰的阈值。不会指定低于此阈值的
峰。噪声定义为 MS/MS 谱图中强度最小的峰。
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表 8-16 Options 对话框 (续)

选项 描述

MS/MS m/z
tolerance (ppm or
mDa)

使用此字段指定 MS/MS m/z 公差。对于要指定离子类型和序列的碎
片峰，其质量准确度必须处在指定的 MS/MS m/z 公差范围内。

Fragmentation Settings

Fragment Types 选择相应的碎片类型。可以选择多个类型。选项包括：

• a

• b

• y

Maximum number
of bonds to break

使用此字段指定要断裂的键最大数量。选项包括：

• 1

• 2

• 3

提示! 对于更复杂的肽，选择 3 作为要断裂的键最大数量会导致所需
的处理时间增加。

Break linkages 如果肽序列中存在键联，则选中此复选框以使单个氨基酸之间的键
断开。

Label Settings

Label peaks with 使用此字段指定应显示在峰标签中的信息。选项包括：

• Ion

• Ion with ppm Error

• Ion with mDa Error

• Ion with Charge

Apply options to all
potential
metabolites

选中此复选框以对所有未指定的代谢物应用当前选项。

指定碎片序列

注释: 碎裂规则内嵌在软件中，不能编辑。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
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Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 在 Show 字段中，选择 Interpretation。

6. 加载序列。请参阅以下章节：加载序列。

7. 在 Sequence 窗格中，单击 Assign。
Fragments 表使用所选的选项填充为已加载序列的解读结果。请参阅以下章节：设置选
项。MS/MS 窗格中增加了绿色竖线，用于指示 Fragments 表中匹配的离子。该表上方的
标签会更新以指示：

• Assigned: x of y peaks。指示已指定的峰的数量。

• MSMS Peak Area Assigned: x%。指示已指定的 MS/MS 峰面积百分比。

• Sequence Coverage: x of y consecutive amino acids。指示序列包含的连续氨基酸
的数量。

关于 Sequence Candidates 选项卡

使用自动序列生成时，Sequence charts 窗格中的 Sequence Candidates 选项卡会填充满足
Options 对话框中所设置条件的选定分解代谢产物或代谢物序列列表。请参阅以下章节：批次
处理选项。软件可为下列类型的代谢物或分解代谢产物生成序列：

• n 裂解：裂解上最多可有四个修饰

• 母体：其中 n 是指任何数量的裂解

序列列表（称为直方图）包含下述信息列：

列 描述

Rank 指示针对指定代谢物发现的所有异构体序列的相对排序。该排序基于指定
的 MS/MS 峰面积。

View sequence
fragments

百分比值指示提议序列的评分。

用户还可通过此列在序列之间切换。请参阅以下章节：在序列之间切换。

AA Index 指示序列的氨基酸首尾。

Apply to
Results

选中复选框表示将会为结果文件保存对应的序列。

候选项总数显示在直方图表格上方，位于 Apply to Results 列正上方。

自动生成的序列不能编辑。用户可以加载序列，进行任何必需的修改，然后选中 Apply to
Results 复选框以将序列包含在结果文件中。请参阅以下章节中的第 7 步：加载序列和编辑序
列。

表征 MS/MS 数据

Molecule Profiler 软件
90/127

软件用户指南
RUO-IDV-05-12707-ZH-A



关于峰标签

峰可以添加以下标签：

• 离子化学式或离子类型（适用于肽）

• 离子化学式或离子类型（适用于肽）以及 ppm 误差

• 离子化学式或离子类型（适用于肽）以及 mDa 误差

• 离子化学式或离子类型（适用于肽）及电荷

向 MS/MS 谱图添加峰标签

1. 在 Interpretation 视图中，单击 Options。
Options 对话框随即打开。

2. 在 Label peaks with 字段中，选择标签类型。

3. 单击 OK。

4. 执行以下任一操作：

表 8-17 添加峰标签

为单个峰添加标签 为所有峰添加标签

在 Fragments 表中，选择包含要标记的峰的
行。

单击 

单击 。 —

提示! 要从 MS/MS 谱图删除所有标签，单击 。

关于肽的解读筛选器

应用筛选器以细化 Fragments 表中显示的数据。要进入 Interpretation Filters 对话框，单击

Fragments 表中的  图标。

筛选器 描述

Mass Range

m/z from __ to __ 仅显示 m/z 值在指定范围内的碎片。

Charge Range

Charge from __ to __ 仅显示电荷在所选范围内的碎片。选项包括：

• From range：1 至 10，包含 1 和 10

• To range：1 至 10，包含 1 和 10

注释: 范围结束值必须大于等于范围起始值。
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筛选器 描述

Ion Type

Fragment type 选择相应的碎片类型。可以选择多个类型。提供了以下选项：

• a

• b

• y

Mass Accuracy

Accuracy within 仅显示质量准确度在指定范围内的碎片。

注释: 质量准确度使用的测量单位是 mDa 还是 ppm 取决于在
Options 对话框中的选择。

Intensity

Intensity above __ cps 仅显示强度值高于指定值的碎片。

寡核苷酸工作流程

加载序列

编辑序列

设置选项

指定碎片序列

关于峰标签 向 MS/MS 谱图添加峰标签

关于寡核苷酸的解读筛选器

加载序列

1. 在 Workspace 面板中，单击 Results。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览并选择结果文件。

4. 单击 OK。

5. 在 Show 字段中，选择 Interpretation。

6. 选择 Potential Metabolites 表中的行。

7. 如果 Sequence 窗格为空，则执行以下操作之一：

• 单击 Load Parent。

• 在窗格中键入或粘贴序列。

表征 MS/MS 数据

Molecule Profiler 软件
92/127

软件用户指南
RUO-IDV-05-12707-ZH-A



下面的标签会添加到该窗格上方：Mono. Mass: [ ], m/z: [ ], Composition: [ ]，其中：

• Mono. Mass：中性成分的单同位素质量。

• m/z：质荷比的值。电荷显示在括号中。

• Composition：序列中不带电荷的元素组成。

8. 如果需要更改，则编辑该序列。请参阅以下章节：编辑序列。

编辑序列

创建或加载特定代谢物的序列之后，可对其进行编辑。

1. 单击需要进行更改的序列。

2. 进行必要的更改。请参阅以下章节：寡核苷酸序列命名惯例。

设置选项

1. 在 Interpretation 视图中，单击 Options。
Options 对话框随即打开。

2. 修改碎裂和标记参数。请参阅表格：表 8-18。

表 8-18 Options 对话框

选项 描述

Minimum signal-to-
noise ratio

使用此字段指定用来指定碎片峰的阈值。不会指定低于此阈值的
峰。噪声定义为 MS/MS 谱图中强度最小的峰。

MS/MS m/z
tolerance (ppm or
mDa)

使用此字段指定 MS/MS m/z 公差。对于要指定离子类型和序列的碎
片峰，其质量准确度必须处在指定的 MS/MS m/z 公差范围内。

Fragmentation Settings

Fragment Types 选择相应的碎片类型。可以选择多个类型。选项包括：

• a

• b

• c

• d

• y

• Other

• wb-H20

• x

• y

请参阅以下章节：自定义寡核苷酸示例。
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表 8-18 Options 对话框 (续)

选项 描述

Maximum number
of bonds to break

使用此字段指定要断裂的键最大数量。选项包括：

• 1

• 2

建议使用值 2。

提示! 对于更复杂的寡核苷酸，选择 3 作为要断裂的键最大数量会导
致所需的处理时间增加。

Maximum water and
Base losses

指定在碎裂过程中可能发生的最大水损失。建议使用值 1。

Label Settings

Label peaks with 使用此字段指定应显示在峰标签中的信息。选项包括：

• Ion

• Ion with ppm Error

• Ion with mDa Error

• Ion with Charge

Apply options to all
potential
metabolites

选中此复选框以对所有未指定的代谢物应用当前选项。

指定碎片序列

注释: 碎裂规则内嵌在软件中，不能编辑。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 在 Show 字段中，选择 Interpretation。

6. 加载序列。请参阅以下章节：加载序列。

7. 在 Sequence 窗格中，单击 Assign。
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Fragments 表使用所选的选项填充为已加载序列的解读结果。请参阅以下章节：设置选
项。MS/MS 窗格中增加了青色竖线，用于指示 Fragments 表中匹配的离子。该表上方的
标签会更新以指示：

• Assigned: x of y peaks。指示已指定的峰的数量。

• MSMS Peak Area Assigned: x%。指示已指定的 MS/MS 峰面积百分比。

• Sequence Coverage: x of y consecutive nucleotides。指示序列包含的连续核苷酸
的数量。

关于峰标签

峰可以添加以下标签：

• 离子化学式或离子类型（适用于寡核苷酸）

• 离子化学式或离子类型（适用于寡核苷酸）以及 ppm 误差

• 离子化学式或离子类型（适用于寡核苷酸）以及 mDa 误差

• 离子化学式或离子类型（适用于寡核苷酸）及电荷

向 MS/MS 谱图添加峰标签

1. 在 Interpretation 视图中，单击 Options。
Options 对话框随即打开。

2. 在 Label peaks with 字段中，选择标签类型。

3. 单击 OK。

4. 执行以下任一操作：

表 8-19 添加峰标签

为单个峰添加标签 为所有峰添加标签

在 Fragments 表中，选择包含要标记的峰的
行。

单击 

单击 。 —

提示! 要从 MS/MS 谱图删除所有标签，单击 。

关于寡核苷酸的解读筛选器

应用筛选器以细化 Fragments 表中显示的数据。要进入 Interpretation Filters 对话框，单击

Fragments 表中的  图标。

筛选器 描述

Mass Range

m/z from __ to __ 仅显示 m/z 值在指定范围内的碎片。
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筛选器 描述

Charge Range

Charge from __ to __ 仅显示电荷高于所选值的碎片。有效值为 1 至 10。

Ion Type

Fragment type 选择相应的碎片类型。可以选择多个类型。提供了以下选项：

• a

• b

• c

• d

• w

• wb-H20

• x

• y

• Other

• Base loss

• Water loss

• Internals

Mass Accuracy

Accuracy within 仅显示质量准确度在指定范围内的碎片。

注释: 质量准确度使用的测量单位是 mDa 还是 ppm 取决于在
Options 对话框中的选择。

Intensity

Intensity above __ cps 仅显示强度值高于指定值的碎片。

ADC 工作流程

加载结构

编辑结构

加载序列

编辑序列

设置选项

为结构和序列指定碎片离子
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关于峰标签 向 MS/MS 谱图添加峰标签

关于 ADC 的解读筛选器

加载结构

在开始代谢物结构测定之前，加载结构可使软件能够确定可能的碎片结构。

注释: 如果未加载结构，仍可向碎片指定可能的化学式。

1. 在 Workspace 面板中，单击 Results。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览并选择结果文件。

4. 单击 OK。

5. 在 Show 字段中，选择 Interpretation。

6. 选择 Potential Metabolites 表中的行。

7. 在 Structure 窗格中，单击 Load，然后选择 Load Parent Structure 选项。
该窗格填充为所选代谢物的母结构。标记的附加位点（可在内嵌处理参数文件中查看）或
原子显示为紫色。

8. 如果需要进行细微更改，则编辑该结构。请参阅以下章节：编辑结构。

编辑结构

加载特定代谢物的结构之后，使用编辑工具进行细微的更改。

提示! 使用编辑工具对结构进行细微的更改，例如代谢转化的不同附着位置。编辑工具不应当
用来创建新结构或对现有结构进行重大更改。

表 8-20 编辑结构

目的 方法

向结构添加原子 在调色板上将特定符号拖动到新位置。添加的原子与距
离最近的现有原子形成单键。

在调色板上创建新原子 单击空白方块，在 Specify Symbol 对话框中键入符
号，然后单击 OK。

提示! 单击添加的方块，键入新符号以创建不同的原
子。

突出显示结构中的一个部分 在所需的原子和键周围拖动出一个圆圈。

表征 MS/MS 数据

软件用户指南
RUO-IDV-05-12707-ZH-A

Molecule Profiler 软件
97/127



表 8-20 编辑结构 (续)

目的 方法

移动一个或多个原子 将结构中突出显示的部分拖动到新位置。如果该部分通
过键与另一个原子结合，则该键移动到新位置。如果该
部分通过键与两个或多个原子结合，则该部分移动，但
现有的键保持不变。

将结构插入到现有结构中 右键单击结构，并单击下面的选项之一：

• Insert .mol File，用于添加另一个结构。

• Insert Conjugate，用于添加特定共轭结构。

删除一个或多个原子 右键单击结构中突出显示的部分，然后单击 Remove
Selected Atoms。

创建键 选择两个未通过键相连的原子，右键单击所选的项，单
击 New Bond，然后选择键类型。

编辑键 右键单击键，单击 Set Bond Type，然后选择键类
型。

删除键 右键单击键，然后单击 Remove Bond。

更改现有原子的电荷状态 右键单击原子，单击 Atom Charge State，然后选择
状态。

提示! 要将编辑后的结构保存为单独的文件，单击 Save As。

提示! 结构可以保存为 mol 或 sdf 文件。在 Save As 对话框中键入相应的扩展名。

加载序列

1. 在 Workspace 面板中，单击 Results。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览并选择肽结果文件。

4. 单击 OK。

5. 在 Show 字段中，选择 Interpretation。

6. 选择 Potential Metabolites 表中的行。

7. 在 Structure 窗格中，单击 Load，然后选择 Load Sequence 选项。
Sequence 窗格填充为所选代谢物的母序列。

8. 选择要共轭的残基，单击右键，然后选择 Mark Residue to Conjugate。
所选残基以紫色显示。

9. 如果需要更改，则编辑该序列。请参阅以下章节：编辑序列。
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编辑序列

创建或加载特定代谢物的序列之后，可对其进行编辑。

1. 单击需要进行更改的序列。

2. 进行必要的更改。请参阅以下章节：肽序列命名惯例。

设置选项

1. 在 Interpretation 视图中，单击 Options。
Options 对话框随即打开。

2. 按下表中所述的方式修改碎裂和标记参数：表 8-21。

表 8-21 Options 对话框

选项 描述

Number of fragment
peaks selected for
structure
assignment

使用此字段指定将为 ADC 的结构部分指定的碎片峰数量。如果它是
峰总数的子集，则按其强度的顺序选择峰。

Minimum signal-to-
noise ratio

使用此字段指定用来指定碎片峰的阈值。不会指定低于此阈值的
峰。

MS/MS m/z
tolerance (ppm or
mDa)

使用此字段指定 MS/MS m/z 公差，单位为 ppm 或 mDa。对于要指
定化学式且还可能指定结构的碎片峰，其质量准确度必须处在指定
的 MS/MS m/z 公差范围内。

Structure Fragmentation Settings

Break aromatic
rings

选中此复选框以断裂芳香环。

Maximum number
of bonds to break

使用此字段指定要断裂的键最大数量。选项包括：

• 1

• 2

• 3

• 4

Maximum number
of C-C bonds to
break

使用此字段指定要断裂的 C-C 键最大数量。选项包括：

• 0

• 1

• 2

• 3

• 4
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表 8-21 Options 对话框 (续)

选项 描述

Sequence Fragmentation Settings

Fragment Types 选择相应的碎片类型。可以选择多个类型。选项包括：

• a

• b

• y

Maximum number
of bonds to break

使用此字段指定要断裂的键最大数量。选项包括：

• 1

• 2

• 3

注释: 对于更复杂的肽，选择 3 作为要断裂的键最大数量会导致所需
的处理时间增加。

Break linkages 如果肽序列中存在键联，则选中此复选框以使单个氨基酸之间的键
断开。

Label Settings

Label peaks with 使用此字段指定应显示在峰标签中的信息。选项包括：

• Ion

• Ion with ppm Error

• Ion with mDa Error

• Ion with Charge

Apply options to all
potential
metabolites

选中此复选框以对所有未指定的代谢物应用当前选项。

为结构和序列指定碎片离子

注释: 碎裂规则内嵌在软件中，不能编辑。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

表征 MS/MS 数据

Molecule Profiler 软件
100/127

软件用户指南
RUO-IDV-05-12707-ZH-A



4. 单击 OK。
Results 视图随即显示出来。

5. 在 Show 字段中，选择 Interpretation。

6. 加载结构和序列。请参阅以下章节：加载结构和加载序列。

注释: 只能加载一个结构或序列。撰写本程序时，假定同时加载了两种。

7. 在 Structure 窗格中，单击 Assign。

默认情况下，TOF MS/MS 谱图下的 Structure 视图和 Sequence 视图都已填充，并显示
Structure 视图。

注释: 如果只加载了母结构，则显示 Fragments 表的 Structures 视图。如果只加载了母序
列，则显示 Fragments 表的 Sequences 视图。

在 Structure 视图中，Fragments 表填充为已识别的碎片，Structure Details 表填充为可
能结构，Contained Neutral Losses 表填充为包含的中性丢失。结果基于所选的选项。请
参阅以下章节：设置选项。MS/MS 窗格中增加了浅蓝色竖线，用于指示 Fragments 表中
匹配的离子。

注释: 如果结构没有解读结果，则 Fragments 表中显示 No structures assigned。

Fragments 表上方的标签指示：

• Assigned: a / b 个峰（结构：x，序列：y），其中 a 是 x 和 y 的总和，指示已指定的
峰的数量，b 指示峰的总数，x 指示 Structures 视图中的行数，y 指示 Sequences 视
图中的行数。

• MSMS Peak Area Assigned: w%，其中 w 指示谱图数据中指定峰的面积百分比。

Fragments 表包含 Use as Conjugate 列。此列包含对表中的每个行进行的检查。如果有
复选框可供选择，则该碎片的提议结构中存在附加位点。如果没有复选框可供选择，则不
存在附加位点。如果选中了该复选框，则碎片用于与序列共轭。如果未选中该复选框，则
不使用碎片。默认情况下，根据准确度和丰度选择最多三个包含附加位点的碎片。表中的
第一行默认选中。

8. 确认已选中 Structures 视图。

9. 如果适合，右键单击每个 Fragments、Structure Details 和 Contained Neutral Losses
表，然后单击 Show Hidden Rows。

注释: 在 Fragments 表中，m/z 值评分最高的行已选中 Use 复选框。在 Structure Details
表中，评分最高的行已选中 Use 复选框。在 Contained Neutral Losses 表中，所有行都
已选中 Use 复选框。

10. 在 Fragments 表中，选中 Use 复选框以识别包含每个 m/z 值的最准确化学式的行。

提示! 在多个行中选中 Use 复选框，可为每个碎片选择多个可能化学式。

指定的 m/z 值显示为加粗斜体。

表征 MS/MS 数据
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11. 在 Structure Details 表中，选中 Use 复选框以识别与所选化学式最准确匹配的结构部
分。

12. 在 Contained Neutral Losses 表中，选中 Use 复选框以识别最准确地反映了包含的中性
丢失的行。

提示! 在 Structure Details 和 Contained Neutral Losses 表中，为特定碎片选中多个行中
的 Use 复选框。

13. 选择 Sequences 视图。

在 Sequence 视图中，Fragments 表根据所选的选项（请参阅以下章节：设置选项）、在
Structures 视图中选择的共轭、在化合物特定参数的 Product Ions and Neutral Losses 选
项卡上进行的选择（请参阅以下章节：Product Ions and Neutral Losses 选项卡）和序
列，填充为解读结果。MS/MS 窗格中增加了绿色竖线，用于指示 Fragments 表中匹配的
离子。

注释: 如果序列没有解读结果，则 Fragments 表中显示 No sequences assigned。

该表上方的标签指示：

• Assigned：a / b 个峰（结构：x，序列：y），其中 a 是 x 和 y 的总和，指示已指定的
峰的数量，b 指示峰的总数，x 指示 Structures 选项卡中的行数，y 指示 Sequences
选项卡中的行数。

• MSMS Peak Area Assigned: w%，其中 w 指示谱图数据中指定峰的面积百分比。

14. 如果适合，右键单击 Fragments 表，然后单击 Show Hidden Rows。

注释: 在 Fragments 表中，m/z 值评分最高的行已选中 Use 复选框。

15. 在 Fragments 表中，选中 Use 复选框以识别包含每个 m/z 值的最准确化学式的行。

提示! 在多个行中选中 Use 复选框，可为每个碎片选择多个可能化学式。

指定的 m/z 值显示为加粗斜体。

16. 完成了所有更改之后，单击 Apply。
这将保存所选代谢物的解读数据。

17. 单击 Save。

提示! 要删除特定代谢物的所有解读数据，单击 Remove。

关于峰标签

峰可以添加以下标签：

• 离子化学式或离子类型（适用于肽）

• 离子化学式或离子类型（适用于肽）以及 ppm 误差

• 离子化学式或离子类型（适用于肽）以及 mDa 误差

• 离子化学式或离子类型（适用于肽）及电荷

表征 MS/MS 数据
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向 MS/MS 谱图添加峰标签

1. 在 Interpretation 视图中，单击 Options。
Options 对话框随即打开。

2. 在 Label peaks with 字段中，选择标签类型。

3. 单击 OK。

4. 执行以下任一操作：

表 8-22 添加峰标签

为单个峰添加标签 为所有峰添加标签

在 Fragments 表中，选择包含要标记的峰的
行。

单击 

单击 。 —

提示! 要从 MS/MS 谱图删除所有标签，单击 。

关于 ADC 的解读筛选器

应用筛选器以细化 Fragments 表中显示的数据。要进入 Interpretation Filters 对话框，单击

Fragments 表中的  图标。

筛选器 描述

Rings and Double Bonds

RDB • Integer value (even-electron)：仅显示环键和双键为整数值
的碎片。

• Non-integer value (odd-electron)：仅显示环键和双键为非
整数值的碎片。

Mass Range

m/z from __ to __ 仅显示 m/z 值在指定范围内的碎片。

Charge Range

Charge from __ to __ 仅显示电荷在所选范围内的碎片。选项包括：

• From range：1 至 10，包含 1 和 10

• To range：1 至 10，包含 1 和 10

注释: 范围结束值必须大于等于范围起始值。

Ion Type

表征 MS/MS 数据
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筛选器 描述

Fragment type 选择相应的碎片类型。可以选择多个类型。选项包括：

• a

• b

• y

Mass Accuracy

Accuracy within 仅显示质量准确度在指定范围内的碎片。

注释: 质量准确度使用的测量单位是 mDa 还是 ppm 取决于在
Options 对话框中的选择。

Intensity

Intensity above __ cps 仅显示强度值高于指定值的碎片。

Score

Score above 仅显示评分高于指定值的碎片。

结构

Fragments with
assigned structures

仅显示与结构关联的碎片。

自动解读

自动解读

小分子工作流程 肽工作流程

小分子工作流程

通过下列方式，可以开始自动生成结构：

• 在 Batch 工作区中，选中 Apply Options 复选框以将在 Batch Processing Options 对话框
中选择的所有 Auto Assign 选项应用于批次中的样本和对照样本。至少必须选择 Assign
Structures or Sequences 选项。请参阅以下章节：批次处理选项。

• 在 Results 工作区的 Interpretation 视图中，单击 MS/MS 窗格中的 Generate。

肽工作流程

通过下列方式，可以开始自动生成序列：

• 在 Batch 工作区中，选中 Options 复选框以将在 Batch Processing Options 对话框中选择
的所有 Auto Assign 选项应用于批次中的样本和对照样本。至少必须选择 Assign
Structures or Sequences 选项。请参阅以下章节：批次处理选项。

表征 MS/MS 数据
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• 在 Results 工作区的 Interpretation 视图中，单击 MS/MS 窗格中的 Generate。

在序列之间切换

单击直方图中蓝色条。
相应的序列将显示在 Sequence 窗格中，Fragments 表更新为与所选序列相关的信息。
Sequence 窗格上方的标签更新，以指示序列编号和指定的排序。例如，序列 x / y，排序 =
z。

选择空窗格

单击直方图中的第一行。
直方图中的第一行包含文字 No sequence。Sequence 窗格清空，Fragments 表刷新，显示

文字 No sequences assigned。

添加序列

注释: 只能向自动生成序列的列表中添加一个序列。如果添加更多序列，则会覆盖前面的用户
添加的序列。

1. 在 Sequence 窗格中，单击 Enter Sequence。
Sequence 窗格清空，Fragments 表刷新并显示文字 No sequence assigned。

2. 单击 Load Parent。
母序列显示在 Sequence 窗格中和 Sequence charts 窗格的 Parent Sequence 选项卡
上。

3. 按下 Tab 以验证母序列。

序列会添加下划线，表示它已生效。在 Sequence Candidates 选项卡上创建新直方图，
用户添加的序列显示在第一个自动生成的序列上一行中。用户添加的序列的序号将为 0。
蓝色条覆盖表格的整个宽度。但是，该条上将不显示百分比。表示已加载序列行的蓝色阴
影将与包含自动生成序列的行中的蓝色稍有不同。提议序列的编号将加一。

用户添加的序列可以编辑。当用户切换出 Sequence 窗格时，对序列进行的任何更改都将
保留在内存中。

选择要查看的序列

单击直方图中蓝色条。
相应的序列将显示在 Sequence 窗格中。Fragments 表更新为与所选序列相关的信息。
Sequence 窗格上方的标签更新，以指示序列编号和指定的排序。例如，序列 x / y，排序 =
z。

删除序列

1. 单击直方图中蓝色条。
相应的序列将显示在 Sequence 窗格中。

2. 在 Sequence 窗格中，单击 Delete。
序列将从 Sequence 窗格中删除，行将从直方图中删除。直方图中的下一条线对应的序列
显示在 Sequence 窗格中，Fragments 表更新为与所选序列相关的信息。

表征 MS/MS 数据
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关联结果 9
在多个感兴趣样本中找到可能代谢物时，可以比较每个样本的结果。这样可供用户查看多个结
果文件生成的可能代谢物之间的不同和相似之处。如果与在 Correlate Results 对话框中设置
的质荷比和保留时间公差匹配，则认为不同结果文件的代谢物相同。

对于寡核苷酸工作流程，软件可以将中性质量相同且符合保留时间公差的多种带电荷的代谢物
归到 Correlation 工作区中的单个条目。此功能称为分组。要启用此功能，在关联结果时选择
Group results by analyte。启用此功能后，将合并多种带电荷的离子，以便于在结果文件之
间进行比较。

注释: 在关联结果文件之前启用分组功能。

准备相关性
1. 单击 File > New > Correlation。

Correlate Results 对话框随即打开。

2. 单击 Add Results。
Open Results 对话框随即打开。

3. 浏览并选择相应的文件。

注释: 所选文件可以包含不同的化合物。模拟数据不是进行关联必需的项。

4. 填写 X-axis title 和 X-axis units 字段。
这样可为 Correlation 工作区中的图形的 X 轴指定标签。

5. 在与 X 轴标签对应的字段中的每个结果文件旁键入一个唯一值。例如，如果在第 4 步指
定的标签为 Time，则在 Time 字段中为每个结果文件键入时间。

6. 如果适用，选择 Include RRF in % area determination。

注释: 不要同时选择 Include RRF in % area determination 和 Group results by
analyte。

如果选择了此选项，则 MS 面积将乘以相对响应因子。面积变化显示在 Correlations
Details 窗格的 Linear Graph、Bar Graph 和 Table 视图中。变化不会显示在 Potential
Metabolites 表中。

7. （寡核苷酸工作流程）如有必要，选择 Group results by analyte 以根据中性质量对峰进
行分组。

8. 自定义相关性。请参阅以下章节：自定义相关性。

9. 在 Correlation file name 字段中，键入文件的名称。

注释: 文件名中不要包含空格。

10. 要选择具体位置以保存相关性文件，单击 Browse，然后选择相应的文件夹。
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11. 单击 OK。
软件会比较在所选文件中找到的代谢物，并将结果显示在 Correlation 工作区中。

提示! 相同的相关性可以使用不同的设置进行处理。在 Correlation 工作区中，单击
Correlate Results。

自定义相关性
选择了要关联的文件之后，编辑 Correlation Results 对话框中的参数值以改善结果。

改善峰分布

可以偏移单个结果文件的保留时间以更好地关联所选文件。

1. 关联结果之前，请执行此操作：

a. 在 Results 工作区中打开每个相应的结果文件。

b. 审核显示在所有文件中的特定代谢物的保留时间。

2. 根据结果文件中显示的偏移，在 Correlate Results 对话框中的特定文件旁边的 R.T. Shift
(min) 字段中键入相应的值。

注释: R.T. Shift (min) 字段接受 -2.00 分钟至 2.00 分钟之间的值。

定义峰合并

特定公差允许将值相似的峰视为相同的峰。

1. 在 Results 工作区中打开每个结果文件。

2. 确定显示在所有文件中的特定代谢物的保留时间和质量偏差。

3. 在 Correlate Results 对话框的 Tolerances 组中，在 Retention time 字段中键入一个值。

注释: Retention time 字段接受 0.01 分钟至 0.25 分钟的值。

4. 在 MS m/z 字段中键入值，然后选择 ppm 或 mDa 作为测量单位。

注释: 在寡核苷酸工作流程中，如果选择了 Group results by analyte 选项，则只有 ppm
可用。

注释: MS m/z 字段接受 0.1 至 250.0 的值。

关于 Correlation 工作区
Correlation 工作区显示在所选结果文件中发现的可能代谢物之间的对比。

关联结果
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图 9-1 Correlation 工作区

项目 描述

1 菜单栏。菜单栏包含以下按钮：
• Correlate Results：打开 Correlate Results 对话框。请参阅以下章

节：准备相关性。

• Open：打开 Open Correlation 对话框，用户可从中浏览到相应的相关
性文件。

• Save：保存当前打开的相关性文件。自动替换现有版本。

• Save As ：保存当前打开的相关性文件。或者，选择目标文件夹并为
相关性文件指定新名称。

2 Potential Metabolites 窗格。根据设置的公差列出所有相关的峰。每行列
出结果文件中的相关可能代谢物、MS Area 和 Analog Area（如适
用）。空 MS Area 单元格表示在特定结果文件中未找到代谢物。空
Analog Area 单元格表示在结果文件中未找到代谢物，或者模拟响应为
零。

此窗格包含以下按钮：

• Select values to filter peaks from the results. ( )：打开
Correlation Filters 对话框，用户可在此设置相关的值，用于从结果中
筛选出不符合条件的信息。请参阅以下章节：关于相关性筛选器。

• Assign ID：根据保留时间和 m/z 值，为 Potential Metabolites 表中的
每个峰指定唯一标识符。

关联结果
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项目 描述

3 Correlation Details 窗格。可供用户比较相关的代谢物。请参阅以下章
节：比较关联代谢物。可以选择不同的代谢物和结果文件。MS 和模拟数
据可使用以下格式显示：

• Linear Graph 或 Bar Graph：比较每个结果文件中出现的每种代谢物
的强度。

• Table：识别在其中找到每种代谢物的结果文件。用户还可以选择在表
中显示出现次数、峰 ID 或峰面积。

注释: 如果在准备关联之前应用了相对响应因子，则定量 MS 数据显示在
线状图和棒图中。

4 Chromatograms 窗格：显示所选代谢物的提取离子色谱图 (XIC) 或模拟色
谱图。色谱图可以包含从一个或所有包含该代谢物的结果文件获得的数
据。

5 MS 窗格：显示从一个或所有包含选定代谢物的结果文件获得的感兴趣样
本 MS 谱图。

6 MS/MS 窗格：显示从一个或所有包含该代谢物的结果文件获得的选定代
谢物 MS/MS 谱图。

注释: 如果对关联结果进行分组，则不显示色谱、MS 和 MS/MS 谱图。

编辑关联代谢物的名称
1. 在 Workspace 面板中，单击 Correlation。

Correlation 工作区随即打开。

2. 单击 Open。
Open Correlation 对话框随即打开。

3. 浏览到相应的关联文件，然后选择该文件。

4. 选择 Potential Metabolites 表中的行。

5. 单击 Edit > Edit Name。
Edit Name 对话框随即打开。

6. 键入新代谢物名称。

7. 单击 OK。
代谢物名称变成新值。

比较关联代谢物
关联包含在多个结果文件中的代谢物之后，用户可以更详细地比较所选的特定代谢物。

1. 在 Workspace 面板中，单击 Correlation。

关联结果
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Correlation 工作区随即打开。

2. 单击 Open。
Open Correlation 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 在 Potential Metabolites 表中，选中要比较的可能代谢物旁边的 Plot 复选框。
代谢物显示在 Correlation Details 窗格中。

5. 要更改特定代谢物的相对响应因子，请在 RRF 字段中键入所需的值。

在线状图和棒图中，MS 面积和模拟面积（如果适用）将乘以 RRF 值。

注释: 只有在准备关联时使用了相对响应因子，才会显示此字段。

6. 要在 Correlation Details 窗格中显示模拟数据，单击 Analog data。

7. 要识别包含所选代谢物的文件，在 Correlation Details 窗格中选择 Table。

8. 要显示归一化数据，单击 。

提示! 归一化数据可显示在线状图、棒图、XIC、模拟色谱图、MS 谱图和 MS/MS 谱图
中。

9. 要根据保留时间和 m/z 值在关联文件中重新指定可能代谢物的峰 ID，单击 Assign ID。

关于相关性筛选器

应用筛选器以进一步细化 Correlation 表中显示的数据。单击  图标进入 Correlation Filters
对话框，或单击 Setup > Filters > Correlation。

筛选器 描述

Mass Range

m/z from __ to __ 仅显示 m/z 值在指定范围内的峰。

Retention Time

R.T. from __ to __ 仅显示保留时间在指定范围内的峰。

Occurrence

Peaks in __ or more
results files

仅显示出现在指定数量的结果文件中的峰。

注释: 最大值取决于为相关性选择的文件数量。例如，如果选择
要关联五个结果文件，则可以选择最多出现五次的峰。
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报告 10
要使用软件生成报告，计算机上必须安装 Microsoft Word 2010 或更高版本。

用户可以创建 Adobe PDF、Microsoft Word 和 HTML 格式的报告。报告还可以直接发送到打
印机。

下列报告模板随软件安装在 C:\ProgramData\SCIEX\Molecule Profiler\Report Templates 文件
夹中：

• Correlation 文件夹

• 相关性详细报告

• 相关性摘要报告

• 相关性分组报告

• ResultsAndInterpret 文件夹

• 解读详细报告

• 解读摘要报告

• 结果详细报告

• 结果摘要报告

• ResultsAndInterpret_ADC 文件夹

• 解读详细报告

• 解读摘要报告

• 结果详细报告

• 结果摘要报告

• ResultsAndInterpret_Peptides 文件夹

• 解读详细报告

• 解读摘要报告

• 结果详细报告

• 结果摘要报告

• ResultsAndInterpret_Oligo 文件夹

• 解读详细报告

• 解读摘要报告

• 结果详细报告

• 结果摘要报告
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虽然每个报告都可以包含许多信息，但是报告仅显示生成报告时正在报告的结果文件的内容。
如果结果文件不包含特定信息，例如同位素富集，则生成的报告将不包含该内容，在大多数情
况下，也将不包含该内容的字段标签或标题。已应用于 Potential Metabolites 表或 Fragments
表的任何筛选器都会反映在报告中。例如，如果筛选 Potential Metabolites 表以仅显示 23 个
峰中的前 5 个，则只有这 5 个峰会包含在报告中。

报告中包含的所有图形或谱图都以默认的缩放等级显示，与在用户界面中选择的缩放等级无
关。所有相关性图形都使用非归一化数据进行报告。

注释: 创建用于分组数据的自定义相关性报告模板时，请确保在文件名称中包括“grouped”。

在 Results 工作区中创建报告
可以为每个小分子、肽和 ADC 结果创建报告。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 OK。
Results 视图随即显示出来。

5. 在 Report 列中，选中要包含在报告中的每个代谢物对应的复选框。
未选中的代谢物不会包含在生成的报告中。

6. 在 Workflow 面板中，单击 Create Report。
Create Report 对话框随即打开。

7. 从 Available templates 字段中选择报告的模板。

有关模板的列表，请参阅以下章节：报告。

8. 选中相应的 Formats 复选框，以创建所需版本的报告文件或打印报告。

注释: 可以选择多种格式。

9. 对于所选的每个格式版本，单击 Browse，然后在 Browse For Folder 对话框中浏览到报
告文件的具体存储位置并选择该位置。

10. 单击 OK。
Browse For Folder 对话框关闭。

11. 对于所选的每个格式版本，在提供的字段中键入报告的名称。

12. （寡核苷酸工作流程）根据需要选择或取消选择 Report grouping table for Results 复
选框。

13. 单击 Generate Report。

14. 如果选择了 Print report 选项，则在 Print 对话框中选择所需的打印选项，然后单击
OK。
软件将会生成报告。
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在 Correlation 工作区中创建报告
可以为每个小分子、肽和 ADC 结果创建相关性报告。

1. 在 Workspace 面板中，单击 Correlation。
Correlation 工作区随即打开。

2. 单击 Open。
Open Correlation 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

4. 单击 Open。
Correlation Results 视图随即显示出来。

5. 要将感兴趣代谢物的相关性细节包含在报告中，请选中 Plot 复选框。

6. 在 Workflow 面板中，单击 Create Report。
Create Report 对话框随即打开。

7. 从 Available templates 字段中选择报告的模板。

有关模板的列表，请参阅以下章节：报告。

注释: 如果相关性文件不包含分组数据，则只有未分组报告模板可用。如果相关性文件包
含分组数据，则仅显示文件名中带有“grouped”的报告模板。

8. 选中相应的 Formats 复选框，以创建所需版本的报告文件或打印报告。

注释: 可以选择多种格式。

9. 对于所选的每个格式版本，单击 Browse，然后在 Browse For Folder 对话框中导航并选
择报告文件的具体存储位置。

10. 单击 OK。
Browse For Folder 对话框关闭。

11. 对于所选的每个格式版本，在提供的字段中键入报告的名称。

12. 单击 Generate Report。

13. 如果选择了 Print report 选项，则在 Print 对话框中选择所需的打印选项，然后单击
OK。
软件将会生成报告。

复制和粘贴图形
可以从 Results 工作区以及 Compound Library 和 Processing Parameters 对话框复制图形。

1. 右键单击要复制的图形，然后单击 Copy Selected Graph。
该图形将复制到剪贴板。

2. 在另一个应用程序中粘贴图形，例如 Microsoft Word。
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复制和粘贴 Potential Metabolites 表
1. 右键单击表格，然后在 Results 工作区中单击 Copy Table。

该表将复制到剪贴板。

2. 在 Excel 中粘贴该表。
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模拟积分 11
模拟数据用于确认使用质谱仪发现的代谢物是实际代谢物，而不是假阳性峰。结合使用模拟和
质谱仪的用户将可使用此功能优化模拟物面积积分，并更好地显示 MS 峰与模拟峰的关系。

如果打开了包含模拟数据的结果文件，则会启用 Potential Metabolites 表中的 Analog
Integration 按钮。

单击 Analog Integration 时，Analog Integration 对话框打开。

除下列例外情况之外，会显示来自 Results 工作区的原始 Potential Metabolites 表：

• 显示没有关联质量峰的任何模拟峰，但与 MS 相关的列为空。

• 如果存在模拟对照数据，紧随 Analog - R.T. (min) 列之后还会显示另一个列 Analog
Signal in Control。如果没有模拟对照数据，则不显示此列。

Analog Signal in Control 列提供下列信息：

• 如果模拟峰的样本-对照品之比大于处理参数中指定的值，则该列中会显示 x。

• 如果模拟峰的样本-对照品之比小于处理参数中指定的值，则该列中会显示选取标记。

手动对模拟数据进行积分

前提条件：

• 结果已经使用模拟数据进行处理。

1. 在 Workspace 面板中，单击 Results。
Results 工作区随即打开。

2. 单击 Open。
Open Results 对话框随即打开。

3. 浏览到相应的文件，然后选择该文件。

注释: 结果文件必须包含模拟色谱图。

4. 单击 OK。
Results 视图随即显示出来。如果结果文件包含模拟数据，则会启用 Potential Metabolites
表中的 Analog Integration 按钮。如果结果文件不包含模拟数据，则此按钮不可用。

5. 单击 Analog Integration。

Analog Integration 对话框随即打开。

除了 Potential Metabolites 表之外，还会显示两个色谱图。第一个色谱图是 Analog
Sample 色谱图，它显示处在通用处理参数的 Chromatographic Data 选项卡中指定保留时
间范围内的所有模拟峰。请参阅以下章节：Chromatographic Data 选项卡。第二个色谱
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图是 MS Sample 的提取离子色谱图 (XIC)，它显示所选行的所有峰。每次在 Potential
Metabolites 表中选择不同的行，XIC 都会更新。

6. 选择 Analog Sample 色谱图，然后在必要时完成下列任务以对数据进行积分：

• 对峰进行手动积分

• 修改现有的峰积分

• 删除峰

在进行更改时，软件自动更新 Analog Sample 色谱图。

7. （可选）选中 Show Controls 复选框。

最多五个对照样本显示在 Analog Sample 色谱图标题下方。请参阅以下章节：显示对照
品。

8. （可选）单击 Baseline Subtract。
基线减除将应用于模拟样本和任何对照品。短语“baseline subtracted”附加到

Analog Sample 色谱图的标题以及任何对照品。请参阅以下章节：执行基线减除。

9. （可选）更改 R.T. Offset。请参阅以下章节：更改保留时间偏移。
保留时间偏移将应用于模拟样本和对照迹线。

10. （可选）应用模拟积分 Options。请参阅以下章节：设置模拟积分选项。

11. 执行以下任一操作：

• 单击 Update Table。请参阅以下章节：更新表。

• 单击 Update Results and Close。请参阅以下章节：更新结果并关闭。

12. 执行以下任一操作：

• 单击 Save 保存当前打开的结果文件，并覆盖现有的版本。

• 单击 Save As 使用新名称保存当前打开的结果文件。现有的结果文件不会更新。

显示对照品
1. 在 Analog Integration 对话框的 Chromatograms 窗格中，选中 Show controls 复选框。

如果适用，在 Chromatograms 窗格的 Analog Sample 标题下显示最多五个对照品。如果
适用，在 XIC 窗格的 MS Sample 标题下显示最多五个对照品。

2. 单击  图标，以展开列表并且显示模拟样本和模拟对照品或 MS 样本和 MS 对照品。

3. 单击  图标，以折叠列表并且仅显示模拟样本或 MS 样本。

4. 再次选中 Show controls 复选框可从视图中删除对照品。

执行基线减除
1. 在 Analog Integration 对话框的 Chromatograms 窗格中，单击 Baseline Subtract。

这样将可减除 Analog Sample 色谱图。基线减除将应用于模拟样本和任何对照品迹线。
短语“baseline subtracted”附加到 Analog Sample 色谱图的名称。

2. 再次单击 Baseline Subtract 可取消基线减除。

模拟积分

Molecule Profiler 软件
116/127

软件用户指南
RUO-IDV-05-12707-ZH-A



短语“baseline subtracted”将从 Analog Sample 色谱图的名称中删除。

更改保留时间偏移
在 Analog Integration 对话框的 Chromatograms 窗格中，使用 R.T. Offset 字段中的上下箭头
更改保留时间偏移。
模拟样本色谱图中的峰偏移量为指定的保留时间偏移。当 Potential Metabolites 表更新或结果
更新时，Analog R.T. (min) 列中的值将更新以反映指定保留时间偏移值的变化。该偏移适用
于模拟样本和对照样本。

设置模拟积分选项
1. 在 Analog Integration 对话框的 Chromatograms 窗格中，单击 Options。

Analog Integration Options 对话框随即打开。

2. 选中要应用的每个选项对应的复选框。

选项 描述

Overlay XIC for
peaks at the
same analog
retention time

叠加模拟保留时间完全相同的这些迹线的 MS 样本 XIC。

Link x-axis 链接模拟样本色谱图与 XIC 色谱图的 X 轴。

3. 单击 OK。

更新表
在 Analog Integration 对话框中进行更改时，将会启用 Update Table 选项。

单击 Update Table。

Potential Metabolites 表的以下列中的信息更新，以反映对模拟峰积分、模拟保留时间和基线
减除进行的任何更改：

• 为 Analog Sample 直方图指定的 Peak ID 可能更新以反映任何手动积分。如果模拟峰的保
留时间与 MS 峰的保留时间匹配且符合指定公差，则可认为模拟峰与 MS 峰匹配。

• Analog - Peak Area 更新以反映任何新积分的面积。

• Analog - % Area 更新以反映算法的任何变化。Analog - % Area 根据所有模拟峰计算，这
些峰可以与 MS 峰相关或与 MS 峰不相关，且处在 Processing Parameters 中指定的时间
范围内。如果模拟峰与多个 MS 峰相关，则为特定 M# 列出的模拟峰面积根据该 M# 的 XIC
MS 面积按比例计算（使用所有相关 MS 峰的峰面积作为总和）。

• Analog - R.T. (min) 更新以反映对保留时间偏移所做的任何更改。

注释: 这些更改不会保存在结果文件中，并可通过单击 Cancel 恢复。
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更新结果并关闭
在 Analog Integration 对话框中进行更改时，将会启用 Update Results and Close 选项。

1. 单击 Update Results and Close。
随即打开一条消息，要求用户确认模拟信息应根据所做的更改进行更新。

2. 单击 Yes。
Analog Integration 对话框关闭。 Potential Metabolites 表的以下列中的信息更新，以反映
对模拟峰积分、模拟保留时间和基线减除进行的任何更改：

• 为 Analog Sample 直方图指定的 Peak ID 可能更新以反映任何手动积分。如果模拟峰
的保留时间与 MS 峰的保留时间匹配且符合指定公差，则可认为模拟峰与 MS 峰匹
配。

• Analog - Peak Area 更新以反映任何新积分的面积。

• Analog - % Area 更新以反映算法的任何变化。Analog - % Area 根据所有模拟峰计
算，这些峰可以与 MS 峰相关或与 MS 峰不相关，且处在 Processing Parameters 中
指定的时间范围内。如果模拟峰与多个 MS 峰相关，则为特定 M# 列出的模拟峰面积根
据该 M# 的 XIC MS 面积按比例计算（使用所有相关 MS 峰的峰面积作为总和）。

• Analog - R.T. (min) 更新以反映对保留时间偏移所做的任何更改。
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故障排除 12
如需特定问题的帮助，请选择相应的链接：

• 无法打开结构文件

• 更改用户权限

• 未找到可能代谢物

• 找到的可能代谢物过多

• 处理时间过长

• 显示 ProgramData 文件夹

• 已知问题和局限

无法打开结构文件
确保结构文件符合下列惯例：

• 格式：mol

• 版本：v2000 或 v3000

• 内容：不包含文本

更改用户权限
安装 Molecule Profiler 软件后，所有用户都有权限读取、写入和删除安装的用户数据文件夹中
的文件。如果更改了权限，则软件可能无法正常工作。

注释: 安装的用户文件夹的默认位置为
C:\ProgramData\SCIEX\Molecule Profiler Data。

未找到可能代谢物
要在感兴趣样本寻找更多代谢物：

• 请选择不同的找峰策略。请参阅以下章节：关于找峰策略。

• 在 Chromatographic Data 选项卡上减小最小色谱强度。请参阅以下章节：
Chromatographic Data 选项卡。

• 在 MS Parameters 选项卡上的 m/z Tolerance 组中增大 MS m/z tolerance。请参阅以下章
节：MS Parameters 选项卡。

• 在 MS Parameters 选项卡上的 m/z Tolerance 组中减小 Minimum MS peak intensity。请
参阅以下章节：MS Parameters 选项卡。
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• （寡核苷酸工作流程）在 MS Parameters 选项卡上的 Isotope Pattern Tolerances 组中增大
Intensity tolerance。

找到的可能代谢物过多
为了减少找到的可能代谢物的数量：

• 请选择不同的找峰策略。请参阅以下章节：关于找峰策略。

• 在 Chromatographic Data 选项卡上增大最小色谱强度。请参阅以下章节：
Chromatographic Data 选项卡。

• 在 Chromatographic Data 选项卡上缩小保留时间窗口。请参阅以下章节：
Chromatographic Data 选项卡。

• 在 MS Parameters 选项卡上缩小质量范围窗口。请参阅以下章节：MS Parameters 选项
卡。

• 在 MS Parameters 选项卡上的 Isotope Pattern Tolerances 组中增大 Minimum MS peak
intensity。请参阅以下章节：MS Parameters 选项卡。

处理时间过长
处理时间受多种因素影响，包括数据复杂性、处理参数、工作站和操作系统。

为了缩短处理所需的时间：

1. 关闭工作站上正在运行的任何其他应用程序。

2. 更改处理参数值：例如：

• 减少所选的算法数量。

• 在 Chromatographic Data 选项卡上增大最小色谱强度。

• 在 Chromatographic Data 选项卡上缩小保留时间窗口。

• 在 MS Parameters 选项卡上增大最小 MS 峰强度。

• 在 MS Parameters 选项卡上缩小质量范围窗口。

• 减少所选的质量亏损过滤数量（仅适用于小分子）。

• 减少生物转化的数量。

• （肽、寡核苷酸和 ADC 工作流程）通过调整化合物特定的参数来减少生成的分解代谢
产物数量。

显示 ProgramData 文件夹
Microsoft Windows 操作系统可能会隐藏 C:\ProgramData 文件夹。安装了 Molecule
Profiler 软件后，请确保所有用户都能查看
C:\ProgramData\SCIEX\Molecule Profiler Data 文件夹。如果该文件夹不可见，则

完成下面的程序：

1. 在 File Explorer 中，单击 View > Options。
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Folder Options 对话框随即打开。

2. 选择 View 选项卡。

3. 单击 Hidden files and folder > Show hidden files, folders, or drives。

4. 单击 Apply。

5. 单击 OK。

已知问题和局限

结果数据

• 在确定 MS 峰面积时，现在采用时间转换因子 60 进行计算。

解读

• 准备结构指定时，在对 Interpret Data 对话框进行了更改之后始终要单击 Find。软件会根
据所选的设置重新计算可用化学式列表。

相关性

• 更改特定代谢物的相对响应因子 (RRF) 时，MS 面积应乘以 RRF 值。所选代谢物更新后的
MS 面积显示在每个线状图、棒图和表格的 Correlation details 窗格中。

报告

• 如果在创建报告时与 Microsoft Word 报告模板发生冲突，则请确保关闭所有 Microsoft
Office 应用程序，然后重试。
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自定义寡核苷酸示例 A
与苄基戊烷交联剂共轭的硫代氨基磷酸酯寡核苷酸结合到 5′-硫代-磷酸酯末端。

序列 化学结构、化学式和单同位素质量

5′-
ATCGATCGTTTAAA-
3′

图 A-1 C149H203N65O57P 14S14 ( 4695.7400)

创建其他基端
按照基本原理图识别构成 5' 交联剂基团的子结构。

自定义寡核苷酸示例
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图 A-2 其他基端

1. 单击 Edit > Custom Elements。

2. 在 Oligo List 选项卡中，单击 New。
New Oligo Residue or Terminus 对话框随即打开。

3. 在 Name 字段中，键入名称，例如 5' benzyl-pentane terminus。
4. 在 Symbol 字段中，键入符号，例如 /CustomBP/。
5. 在 Composition Type 字段中，选择 Other Terminus。

6. 完成其他基端的字段。

表 A-1 其他基端字段

字段 值

Terminus Moiety C11H15
Terminus Linker O
Phosphate Core HOPS

7. 单击 OK。
随即显示 Warning 对话框以及消息：The "Terminus Moiety" field is usually
odd electron.Do you want to continue?

8. 单击 OK。
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创建内部残基作为其他残基
按照基本原理图识别构成自定义碱基的子结构。

图 A-3 其他残基

1. 单击 Edit > Custom Elements。

2. 在 Oligo List 选项卡中，单击 New。

提示! 创建自定义残基时，定义所有四种核苷酸。建议创建单个核苷酸，然后单击 New
From 创建其余三种核苷酸。

New Oligo Residue or Terminus 对话框随即打开。

3. 对于腺嘌呤核苷酸，请执行以下步骤：

a. 在 Name 字段中，键入 Custom dA。
b. 在 Symbol 字段中，键入 /CustomdA/。
c. 在 Composition Type 字段中，选择 Other Residue。

d. 完成其他残基的字段。

自定义寡核苷酸示例
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表 A-2 其他残基字段

字段 值

Base C5H4N5
5' Linker O
Sugar Core C5H70
3' Linker NH
Phosphate Core HPOS

e. 单击 OK。
随即显示 Warning 对话框以及消息：The "Sugar Core" field is usually
odd electron.Do you want to continue?

f. 单击 OK。

4. 对于其余三种核苷酸，各自执行此操作：

a. 选择 /CustomdA/，然后单击 New From。
New Oligo Residue or Terminus 对话框随即打开。

b. 键入 Name、Symbol 和 Base。关于碱基化学式，请参考下表。

表 A-3 碱基化学式

核苷酸 名称 符号 碱基

胸腺嘧啶 Custom dT /CustomdT/ C5H5N2O2

鸟嘌呤 Custom dG /CustomdG/ C5H4N5O

胞嘧啶 Custom dC /CustomdC/ C4H4N3O

c. 单击 OK。

编写自定义序列
1. 单击 New > Oligonucleotide。

2. 在 Sequence 窗格中，键入：

/CustomBP/ /CustomdA//CustomdT//CustomdC/ /CustomdG//CustomdA//CustomdT/ /
CustomdC//CustomdG//CustomdT/ /CustomdT//CustomdT//CustomdA/ /CustomdA//
CustomdA/

3. 单击 Chemical formula 字段。
C149H203N65O57P14S14 显示在该字段中。
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术语表 B
软件如何命名代谢物
通过两种方式为可能代谢物指定名称。如果峰是预测的代谢物，则其名称基于匹配生物转化、
裂解代谢物或二者的组合。如果峰是意外代谢物，则根据损失或增益命名。

软件还会为每种代谢物指定可能化学式。用户可以从软件推荐的化学式列表中选择不同的化学
式，或者手动键入化学式，以更改该化学式。

IDA
IDA 方法在采集过程中查找全扫描谱图中的离子，然后实时决定 MS/MS 分析哪些离子。

峰 ID
软件根据保留时间和 m/z 值，使用 M1、M2、M3 等标记可能代谢物。

相对响应因子
相对响应因子 (RRF) 是在人为地增大或减小峰面积时用于与峰面积相乘的值。它可以改变相
关性详细信息图形中的峰面积描绘。

参考谱图
识别可能代谢物时所使用的特定化合物的 MS/MS 谱图。

术语表
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联系我们

客户培训
• 北美地区：NA.CustomerTraining@sciex.com

• 欧洲：Europe.CustomerTraining@sciex.com

• 在欧盟与北美之外请访问 sciex.com/education

在线学习中心
• SCIEX Now Learning Hub

SCIEX 支持
SCIEX 及其代表在全球范围内设有经过系统培训的服务和技术专家。他们可以解答系统问题
或可能出现的任何技术问题。详情请访问 SCIEX 网站 sciex.com 或通过下述方式之一联系我
们：

• sciex.com/contact-us

• sciex.com/request-support

网络安全
有关 SCIEX 产品的最新网络安全指南，请访问 sciex.com/productsecurity。

文档
本版本的文档取代本文档的所有先前版本。

要查看本文档的电子版本，需要 Adobe Acrobat Reader。要下载最新版本，请转到 https://
get.adobe.com/reader。

最新版本的文档可从 SCIEX 网站上获得，网址：sciex.com/customer-documents。

注释: 如需免费获取本文档的印刷版本，请联系 sciex.com/contact-us。
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